Horus User Manual

Revision 0.35  2016/11/08
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Horus Warranty Information</td>
<td>9</td>
</tr>
<tr>
<td>Contacting Merging</td>
<td>9</td>
</tr>
<tr>
<td>Introduction to Horus</td>
<td>11</td>
</tr>
<tr>
<td>Horus block diagram</td>
<td>11</td>
</tr>
<tr>
<td>Horus modules interconnection diagram</td>
<td>13</td>
</tr>
<tr>
<td>Horus optional cards</td>
<td>16</td>
</tr>
<tr>
<td>Horus cables</td>
<td>33</td>
</tr>
<tr>
<td>Horus key features</td>
<td>38</td>
</tr>
<tr>
<td>Horus Modules Capabilities</td>
<td>40</td>
</tr>
<tr>
<td>Horus Modules Latencies</td>
<td>40</td>
</tr>
<tr>
<td>Installing an additional Horus I/O Module</td>
<td>41</td>
</tr>
<tr>
<td>Installing an additional Horus MADI Extension Module (MADM or MADS)</td>
<td>42</td>
</tr>
<tr>
<td>Installing the Merging PCIe Ethernet Controller Card NET-MSC-GBEX1</td>
<td>45</td>
</tr>
<tr>
<td>Horus recommended placement in Rack</td>
<td>47</td>
</tr>
<tr>
<td>Horus power ON</td>
<td>47</td>
</tr>
<tr>
<td>Horus touch screen control interface</td>
<td>48</td>
</tr>
<tr>
<td>Horus Menu Hierarchy</td>
<td>48</td>
</tr>
<tr>
<td>Main Home Screen</td>
<td>49</td>
</tr>
<tr>
<td>Headphone Menu</td>
<td>49</td>
</tr>
<tr>
<td>Meters Menu</td>
<td>50</td>
</tr>
<tr>
<td>Meters Settings Menu</td>
<td>50</td>
</tr>
<tr>
<td>IO &amp; Sync Menu</td>
<td>51</td>
</tr>
<tr>
<td>Timecode Menu (I/O &amp; Sync)</td>
<td>52</td>
</tr>
<tr>
<td>REFS Menu (I/O &amp; Sync)</td>
<td>53</td>
</tr>
<tr>
<td>PreAmp Menu</td>
<td>53</td>
</tr>
<tr>
<td>Setup Menu</td>
<td>56</td>
</tr>
<tr>
<td>Formats Menu (Setup)</td>
<td>57</td>
</tr>
<tr>
<td>Routing Menu (Setup)</td>
<td>58</td>
</tr>
<tr>
<td>Modules Menu (Setup)</td>
<td>60</td>
</tr>
<tr>
<td>Modules: MADI Sub-Menu</td>
<td>61</td>
</tr>
<tr>
<td>Modules: AES Sub-Menu</td>
<td>62</td>
</tr>
<tr>
<td>Modules: A/D Sub-Menu</td>
<td>62</td>
</tr>
<tr>
<td>Modules: ADA Sub-Menu</td>
<td>63</td>
</tr>
<tr>
<td>Modules: D/A Sub-Menu</td>
<td>64</td>
</tr>
<tr>
<td>Modules: PT Sub-Menu</td>
<td>65</td>
</tr>
<tr>
<td>Modules: Loopback (hidden menu, available only for debug use)</td>
<td>66</td>
</tr>
<tr>
<td>Presets Menu (Setup)</td>
<td>67</td>
</tr>
<tr>
<td>System (Setup)</td>
<td>68</td>
</tr>
<tr>
<td>Network Menu (Setup)</td>
<td>69</td>
</tr>
<tr>
<td>Info (Setup)</td>
<td>70</td>
</tr>
<tr>
<td>Horus Web Control access</td>
<td>71</td>
</tr>
<tr>
<td>Installing and accessing the Horus Control interface remotely</td>
<td>71</td>
</tr>
<tr>
<td>The Horus embedded User Manual</td>
<td>75</td>
</tr>
<tr>
<td>Horus &amp; Hapi setup examples</td>
<td>77</td>
</tr>
<tr>
<td>Hardware setup</td>
<td>83</td>
</tr>
<tr>
<td>In Horus</td>
<td>83</td>
</tr>
<tr>
<td>In Pro Tools</td>
<td>83</td>
</tr>
<tr>
<td>Block Diagram</td>
<td>85</td>
</tr>
<tr>
<td>Horus MIDI Din</td>
<td>87</td>
</tr>
</tbody>
</table>
Horus User Manual

Horus Firmware update procedure .................................................................................................................. 876

Horus troubleshooting ....................................................................................................................................... 90
Horus on screen Error Report .......................................................................................................................... 90
How to provide Merging Support with a Horus debug dump file ................................................................. 90
Cannot access Horus remotely in Maintenance mode for Firmware update ................................................. 93
Firewall and Antivirus ...................................................................................................................................... 93
Symptom: Horus does not start up or will after a few minutes ........................................................................ 94
IMPORTANT SAFETY AND INSTALLATION INSTRUCTION
SAVE THESE INSTRUCTIONS

INSTRUCTIONS PERTAINING TO RISK OF FIRE, ELECTRIC SHOCK, OR INJURY TO PERSONS

WARNING – when using electric products, basic precautions should be followed, including the following:

1. Read all of the safety and installations instructions and explanation of graphic symbols before using the product.

2. The product must be grounded. If it should malfunction or breakdown, grounding provides a path of least resistance or electric current to reduce the risk of electric shock. This product is equipped with a power supply cord having an equipment-grounding conductor and a grounding plug. The plug must be plugged into an appropriate outlet which is properly installed and grounded in accordance with all local codes and ordinances.

DANGER – Improper connection of the equipment-grounding can result in a risk of electric shock. Do not modify the plug provided with the product – if it will not fit the outlet have a proper outlet installed by a qualified electrician. Do not use an adapter that defeats the function of the equipment-grounding conductor. If you are in doubt as to whether the product is properly grounded, check with a qualified serviceman or electrician.

3. Do not use this product near water – for example, near a bathtub, washbowl, kitchen sink, in a wet basement, or near a swimming pool, or the like.

4. This product should only be used with a stand or cart that is recommended by the manufacture.

5. This product, either alone or in combination with an amplifier and speakers or headphones, may be capable of producing sound levels that could cause permanent hearing loss. Do not operate at a high volume level or at a level that is uncomfortable. If you experience any hearing loss or ringing in the ears, you should consult an audiologist.

6. The product should be located so that its location or position does not interfere with its proper ventilation.

7. The product should be located away from heat sources such as radiators, heat registers, or other products that produce heat.

8. The product should be connected to a power supply only of the type described in the operating instructions or as marked on the product.

9. The power-supply cord of the product should be unplugged from the outlet when left unused for a long period of time. When unplugging the power supply, do not pull on the cord, but grasp it by the plug.

10. Care should be taken so that objects do not fall and liquids are not spilled into the enclosure through openings.

11. The product should be serviced by qualified service personnel when: A. The power supply cord or plug has been damaged. Objects have fallen, or liquid has spilled into the product, or C. The product has been exposed to rain, or D. The product does not appear to be operating normally or exhibits a
marked change in performance, or E. The product has been dropped, or the enclosure damaged.

12. Do not attempt to service the product beyond that described in the user maintenance instructions. All other servicing should be referred to qualified service personnel.

13. WARNING - Do not place objects on the power supply cord, or place the product in a position where anyone could trip over, walk on, or roll anything over cords of any type. Do not allow the product to rest on or be installed over cords of any type. Improper installations of this type create the possibility of a fire hazard and/or personal injury.

The lightning flash with arrowhead symbol, within an equilateral triangle, is intended to alert the user to the presence of uninsulated "dangerous voltage" within the product's enclosure that may be of sufficient magnitude to constitute a risk of electric shock to persons.

The exclamation point within an equilateral triangle is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the product.

No part of this documentation may reproduced in any form whatsoever or be stored in any data retrieval system without prior written permission of the copyright owners. This documentation is supplied on an as-is basis. Information contained within this documentation is subject to change at any time without notice and must not be relied upon. All company and product names are ™ or Registered Trademarks ® of their respective owners. Windows 7 is a trademark of Microsoft Corporation. Merging Technologies makes no warranties express or implied regarding the Horus embedded software, its quality, performance, merchantability or fitness for a particular purpose. The software is supplied “as is” you, the purchaser, are assuming the entire risk of the results of using this Merging Technologies software. In no circumstances will Merging Technologies, its owners, directors, officers, employees or agents be liable to you for any consequential, incidental or indirect loss or damages including loss of time, loss of business, loss of profits, loss of data or similar resulting from the use of or inability to use the Merging Technologies hardware and or software or for any defect in the hardware software or documentation.

© Copyright Merging Technologies Inc. 2014. All rights reserved.
IMPORTANT NOTICE:
Please read the following information very carefully before attempting any installation. Failure to comply with the precise instructions may result in damage to your Merging hardware. Please read this entire section of the manual carefully before installation.

STATIC DANGER NOTICE:
Please note that the Horus contains delicate electronic components that can be damaged or even destroyed when exposed to static electricity. Take all necessary precautions not to discharge static electricity when touching any of the Horus connectors.

Product Regulatory Compliance
The Merging Horus Network Converter is designed and tested to meet the standards and regulations listed in the following sections.

Product Safety Compliance
Horus complies with the following safety requirements:
- EN 60 950 (European Union).
- IEC 60 950 (International).
- EMKO-TSE (74-SEC) 207/94 (Nordics).

Product EMC Compliance
The system has been tested and verified to comply with the following EMC regulations:
- FCC (Class A Verification) – Radiated and Conducted Emissions (USA).
- EN45022 (Class A) – Radiated and Conducted Emissions (European Union).
- EN45024 (Immunity) (European Union).
- EN6100-3-2 & -3 (Power Harmonics and Fluctuation and Flicker).

Electromagnetic Compatibility Notices
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference and (2), this device must accept any interference received, including interference that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment to an outlet on a circuit other than the one to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
Any changes or modifications not expressly approved by the grantee of this device could void the user’s authority to operate the equipment. The customer is responsible for ensuring compliance of the modified product.
Only peripherals (computer input/output devices, Ethernet switches, terminals, printers, etc.) that comply with FCC Class B limits may be attached to this computer product. Operation with noncompliant peripherals is likely to result in interference to radio and TV reception.
All cables used to connect to peripherals must be shielded and grounded. Operation with cables, connected to peripherals that are not shielded and grounded, may result in interference to radio and TV reception.
Environmental Limits

**System Office Environment Parameter Limits**

Operating Temperature: +5 degrees C to +45 degrees C with the maximum rate of change not to exceed 10 degrees C per hour.

Non-Operating Temperature: -40 degrees C to +70 degrees C

Non-Operating Humidity: 95%, non-condensing @ 30 degrees C

Acoustic noise less than 20 dBA (Coding Mode set to Low, internal Temperature 45 degrees C, as typical with 3 x Analog modules fitted) with an ambient Temperature (18-25 degrees C)

Operating Shock: No errors with a half sine wave shock of 2G (with 11-millisecond duration).

Package Shock: Operational after a free fall, 18 – 24 inch depending on the weight.

ESD: 15kV per Merging Environmental Test Specification
Declaration of Conformity

According to

**EMC Directive 2004/108/EC**

**Product**  Horus

**Manufacturer**  Merging Technologies SA
Le Verney 4
CH-1070 Puidoux
Switzerland

**Electrical Rating**  90-260 VAC, 50/60 Hz, 0.2 A (at 230V)


Detailed specifications of the tested and certified product are shown in the following Test Report:

Test report Ref No: 16’835 Issued Date: June 2012 by Montena EMC SA

The CE label is affixed on the rear of left side of the Horus unit as per below:

Date 12 June 2012

Claude Cellier
President
Merging Technologies S.A.
Horus Warranty Information

This product is warranted to be free of defects in materials and workmanship for a period of one year from the date of purchase. Merging Technologies, Inc. extends this Limited Warranty to the original purchaser. In the event of a defect or failure to confirm to this Limited warranty, Merging Technologies, Inc. will repair or replace the product without charge within sixty (60) days. In order to make a claim under this limited warranty, the purchaser must notify Merging Technologies, Inc. or their representative in writing, of the product failure. In this limited warranty the customer must upon Merging Technologies, Inc. request, return the product to the place of purchase, or other local designation, for the necessary repairs to be performed. If the consumer is not satisfied with the repair, Merging Technologies, Inc. will have the option to either attempt a further repair, or refund the purchase price.

This warranty does not cover: (1) Products which have been subject to misuse, abuse, accident, physical damage, neglect, exposure to fire, water or excessive changes in the climate or temperature, or operation outside maximum rating. (2) Products on which warranty stickers or product serial numbers have been removed, altered or rendered illegible. (3) The cost of installations, removal or reinstallation. (4) Damages caused to any other products. (5) Do not attempt to service the equipment. There are no user serviceable parts inside*. Please refer all servicing to an authorized Merging sales partner. Any attempt to service the equipment will expose you to a risk of electric shock, and will void the manufacturer’s warranty.

* Replacing or adding a AD, DA or MADI module and adjusting the DA module dip switch (output) is permitted under the supervision of a Merging sales partner. Any other modification will void the Horus warranty.

Contacting Merging

International Office:
Merging Technologies S.A.
Le Verney 4
CH-1070 Puidoux
Switzerland

Phone: +41 21 946 0444
Fax: +41 21 946 0445

USA:

Merging USA (Independent Audio)
43 Deerfield Road
Portland,
ME 04101-1805
United States of America

Phone: +1 (207) 773 2424
Fax: +1 (207) 773 2422

For all documentation inquiries or suggestions for improvement:
www.merging.com

© 2014 All rights reserved. Merging Technologies and Horus are registered Trademarks of Merging technologies SA.
Product features and specifications are subject to change without notice.
Merging Technologies SA shall not be liable for technical or editorial errors contained herein, nor for incidental or consequential damages resulting from the furnishing, performance or use of this manual.
Introduction to Horus

Modular by Design
Horus was designed to give its users an amazing amount of Audio I/O channels, over all the most commonly deployed formats, while offering an unprecedented level of quality in such a small form factor. Providing as standard 64 channels of MADI and 24 channel of AES-EBU I/O, you may choose to add up to 6 Analog I/O optional modules and one additional MADI extension module to bring the total MADI capacity to 128 channels and thereby create the ultimate audio interface for your studio, whatever the size. Once the Horus is fully loaded with option cards, it is capable of achieving an astonishing 176 inputs and 178 outputs @ 1FS There are indeed 2 more output channels than input channels, including the Stereo Headphone Monitoring.

Route Signal Anywhere
Horus has been designed so that any input can be routed to any number of outputs as required simultaneously. With comprehensive routing pages accessible both locally on the touchscreen and by remote access using a standard web browser, Horus is the answer to signal flow management in your studio.

Green Built
For environmentally-conscious users, Horus has been designed meticulously in order to keep power consumption at an incredible minimum. A fully loaded Horus running all channels of phantom power will only draw about 60W, making it more affordable to run than your kitchen lights.

HORUS Key Features
• Up to 76 inputs and 178 outputs @1FS
• Works from 44.1 kHz to 192 kHz (Premium up to DXD/DSD256)
• Signal routing from any input to any combination of outputs
• Works as MADI/AES AD/DA for “standard” operation... AND
• Works in RAVENNA mode to deliver all I/O via the network
• Front panel touch screen for local access
• Front panel Stereo Headphone monitoring
• Browser-based remote access using any web enabled device
• Dual redundant power supply option
• Modular design for analog and additional Digital I/O
• Near-zero latency from in to out (<1ms)

RAVENNA
The Horus has been designed so that the MADI, AES and Analog modules can all feed into or take their sources from the network over RAVENNA streams, providing up to 176 channels of I/O @ 1FS over a single CAT5e or CAT6 cable to any other RAVENNA devices on the network.

The RAVENNA connection on the Horus allows for not only audio, but also control and sync information to flow through as well. Send Timecodes and Wordclock directly to the Horus unit over the same network as your audio. The RAVENNA port even provides for remote control access to the configuration and entire routing of the unit itself! Support for: LTC/Video Ref/WCK

RAVENNA is a layer 3 IP based protocol. In environments where existing networks are already in place, RAVENNA subnets can slip right into place with no additional outlay. In laymen’s terms, this means that you can connect your Horus to a properly configured network exactly as you would your PC or Mac, with no additional technology required.

RAVENNA is a “mission critical” protocol, meaning that is has been designed to ensure immensely low jitter rates and latencies (sub-millisecond) and ensures that every single sample gets to where it needs to go without fail. Horus also provides a secondary, redundant RAVENNA connection allowing for uninterrupted use, even when a network connection fails. Refer to the RAVENNA User Guide and the MassCore-RAVENNA Configuration Guide for more details

Horus block diagram
Horus modules interconnection diagram
HORUS HARDWARE

FRONT PANEL

BACK PANEL

HORUS UNIT DESCRIPTION
HORUS BASE UNIT

IOC-HORUS Specifications
Case Material
Front Panel Material
Weight (excluding redundant PS)
Dimensions (2U rack mounting)
Voltage (AC)
Power Consumption (Max)
Front Panel TFT size/resolution

Headphone Monitor Jacks
Headphone Jack 1&2
Max output Level (Unbalanced)
Output Impedance
Dynamic Range (A-weighted, typ.)
THD+N (1 kHz) @ -2 dBFS
Gain Range (software controlled)
Gain Step/Precision

SYNC Connectors
“Sync” Cable (LTC/Video Ref)
LTC In & Out (via “Sync” Cable)
Video Reference In (via “Sync” Cable)
Word Clock Input (Switchable 75 Ω Termination)
Word Clock Output (Zout = 35 Ω)
Maximum supported deviation

RAVENNA module
RAVENNA Primary / Secondary (GbE)

AES-EBU module
AES type/pinout
AES I/O
Input & Output Impedance

MADI module
MADI types (Coaxial / Optical)
Input & Output Impedance

Software Specifications
RAVENNA MassCore Driver
Windows Driver/OS
Mac Driver/OS

= 35 Ω)
Load = 300 Ohms +15 dBu
75 Ω
109 dB
< -100 dB (0.001 %)
-60 dB to +12 dB
1dB / ±0.05 dB

6.3 mm (1/4") / 3.5mm
D-Sub 15Pin
Balanced XLR
BNC
BNC, 0.5Vp-p min
BNC, 5Vp-p
+/-1000 ppm

RJ45
DB-25 / AES59 (Tascam Dig.)
Grounded and transformer coupled
110 Ω
BNC / SC
75 Ω
Pyramix 8.0 or Higher / Win7 32 or 64bit
ASIO 2.2 /Win7 32 or 64bit
CoreAudio / MacOS 10.8.5 or higher (Intel)
Horus optional cards

IOM-H-AKD8D / AKD8DP
These remotely controlled Mic/Line Input cards have set a new benchmark in analog circuitry design, and provide additionally a Line level post Mic-pre “Direct Out” output. Available in models that work up to 192kHz (AKD8D) and DXD/DSD256 (AKD8DP)

IOM-H-AKD8D / AKD8DP Key Features
• 8 x exceptionally transparent, Swiss designed pre-amplifiers
• Remote/Local switch to Line Level on a per channel basis
• Completely accessible remotely for all parameter changes
• Phantom Power/Phase/Low Cut switchable per channel
• Remover the need for DI boxes
• Allows build-in Mic splitting variants
• Better than 120dB dynamic range

IOM-H-AKD8D / AKD8DP Mic Pre-Amp + ADC
Mic Pre Max Input (Pad On / Pad Off) +24 dBu / +13 dBu
Input Impedance (Differential, Software Switchable Per Channel) 1.9 kΩ / 10 kΩ
Input Impedance with +48V ON (Diff., Soft. Switchable Per Channel) 1.9 kΩ / 10 kΩ
Dynamic Range (A-weighted, typ.) , ref +10 dBu 123.5 dB
Gain Range (software controlled) 0 dB to +66 dB
Gain Step/Precision 0.5 dB / ±0.2 dB
THD+N Pre + A/D (20 Hz - 20 kHz) @ -2 dBFS (AD8/AD8P) < -110 dB (0.00031%)/-111 dB (0.00028%)
Interchannel Crosstalk @ 1kHz, typ. < -125 dB
EIN @ >40 dB Gain (150Ω Source Impedance, A-weighted, typ.) < -128 dBu
Common Mode Rejection Rate (20 Hz – 20 kHz) > 60 dB (up to 0 dBFS)
Phantom Power (Software Switchable Per Channel) +48V
Phase Reverse (Software Switchable Per Channel) YES
Low Cut filter (Software Switchable Per Channel) -12 dB/octave, 80 Hz

Line Input
Max Line Input for 0 dBFS +24 dBu
Input Impedance (Differential) 10 kΩ
Dynamic Range (A-weighted, typ), ref +24 dBu 124 dB
THD+N Line+A/D (20 Hz - 20 kHz) @ -10 dBFS < -110 dB (0.00031%)/-111 dB (0.00028%)
Interchannel Crosstalk @ 1kHz @ fullscale < -130 dB
Sensitivity Range for 0 dBFS (software controlled) -42 dBu to +24 dBu
Gain Step/Precision 0.5 dB / ±0.2 dB
Common Mode Rejection Rate (20 Hz – 20 kHz) > 60 dB / > 65dB (both up to 0 dBFS)
Connector Pinout DB-25 / AES59 (Tascam Ana.)
IOM-H-AKD8D / AKD8DP Mic-Pre Analog Section

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency response +0/-0.5 dB, Line</td>
<td>2 Hz - &gt; 200 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-2.0 dB, Line</td>
<td>1 Hz - &gt; 200 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-0.5 dB, Mic, at G=40dB</td>
<td>2 Hz - 65 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-2.0 dB, Mic, at G=40dB</td>
<td>1 Hz - 160 kHz</td>
</tr>
<tr>
<td>THD+N (1 kHz), Line/Mic at G=0dB</td>
<td>&lt; -115 dB (0.00018 %)</td>
</tr>
<tr>
<td>THD+N (20 Hz-20 kHz), Line/Mic at G=0dB</td>
<td>&lt; -112 dB (0.00025 %)</td>
</tr>
<tr>
<td>Interchannel Crosstalk @ 1kHz, typ.</td>
<td>-140dB</td>
</tr>
<tr>
<td>5° low-end in-channel Ø deviation pt: Line</td>
<td>9 Hz</td>
</tr>
<tr>
<td>5° low-end in-channel Ø deviation pt: Mic</td>
<td>9 Hz</td>
</tr>
<tr>
<td>Interchannel phase 10 Hz - 100 kHz</td>
<td>&lt; ±0.1°</td>
</tr>
</tbody>
</table>

IOM-H-AKD8D / AKD8DP Direct Out Section

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency response +0/-0.5dB @ Gain 40dB</td>
<td>2 Hz - 65kHz</td>
</tr>
<tr>
<td>Max Direct Output level typ.</td>
<td>+24 dBu / +13 dBu</td>
</tr>
<tr>
<td>Output Impedance (Differential)</td>
<td>&lt; 100 Ω</td>
</tr>
<tr>
<td>Dynamic Range (20 Hz – 22 kHz, typ)</td>
<td>140 dB</td>
</tr>
<tr>
<td>THD+N (1 kHz) @ +10dBu</td>
<td>&lt; -120dB (0.0001 %)</td>
</tr>
<tr>
<td>Input Connector Pinout</td>
<td>DB-25 / AES59 (Tascam Ana.)</td>
</tr>
<tr>
<td>Direct Output Connector Pinout</td>
<td>DB-25 / AES59 (Tascam Ana.)</td>
</tr>
</tbody>
</table>

**Gain behavior of the Direct Out section**

As the Direct Out output is taken just after the Mic-pre analog section, the gain adjustments are not as smooth and linear as after the digital conversion. The figure below shows the behaviour of the gain on the Direct Out (in blue) compared to the gain on the digital side (in red).

Note: on the Direct Out the maximum available gain is + 40.1 dB.
IOM-H-AKD8D/AKD8DP block diagram

Data flow in PCM on AKD8DP cards (run 12 and above)

Data flow in DSD on AKD8DP cards (run 12 and above)
IOM-H-AD8D / AD8DP
These remotely controlled Mic/Line Input cards have set a new benchmark in analog circuitry design, and provide additionally a Line level post Mic-pre “Direct Out” output.
Available in models that work up to 192kHz (AD8D) and DXD/DSD256 (AD8DP)

IOM-H-AD8D / AD8DP Key Features
• 8 x exceptionally transparent, Swiss designed pre-amplifiers
• Remote/Local switch to Line Level on a per channel basis
• Completely accessible remotely for all parameter changes
• Phantom Power/Phase/Low Cut switchable per channel
• Removes the need for DI boxes
• Allows build-in Mic splitting variants
• Better than 120dB dynamic range

IOM-H-AD8D / AD8DP Mic Pre-Amp + ADC
Mic Pre Max Input (Pad On / Pad Off) +24 dBu / +13 dBu
Input Impedance (Differential, Software Switchable Per Channel) 2 kΩ / 13.6 kΩ
Input Impedance with +48V ON (Diff., Soft. Switchable Per Channel) 1.7 kΩ / 6.8 kΩ
Dynamic Range (A-weighted, typ.) , ref +10 dBu 127 dB
Gain Range (software controlled) 0 dB to +66 dB
Gain Step/Precision 0.5 dB / ±0.2 dB
THD+N Pre + A/D (20 Hz-20 kHz) @ -2 dBFS (AD8/AD8P) <-96dB (0.0016 %) / -100 dB (0.001 %)
Interchannel Crosstalk @ 1kHz, typ. < -125 dB
EIN @ >40 dB Gain (150Ω Source Impedance, A-weighted, typ.) <-128 dBu
Common Mode Rejection Rate (20 Hz – 20 kHz) > 60 dB (up to 0 dBFS)
Phantom Power (Software Switchable Per Channel) +48V
Phase Reverse (Software Switchable Per Channel) YES
Low Cut filter (Software Switchable Per Channel) -12 dB/octave, 80 Hz

Line Input
Max Line Input for 0 dBFS +24 dBu
Input Impedance (Differential) 13.6 kΩ
Dynamic Range (A-weighted, typ), ref +24 dBu 120 dB
THD+N Line+ A/D (20 Hz - 20 kHz) @ -12 dBFS < -100 dB (0.001 %)
Interchannel Crosstalk @ 1kHz @ fullscale < -120 dB
Sensitivity Range for 0 dBFS (software controlled) -42 dBu to +24 dBu
Gain Step/Precision 0.5 dB / ±0.2 dB
Common Mode Rejection Rate (20 Hz – 20 kHz) > 60 dB (up to 0 dBFS)
Connector Pinout DB-25 / AES59 (Tascam Ana.)
IOM-H-AD8D/AD8DP Mic-Pre Analog Section

<table>
<thead>
<tr>
<th>Specification</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency response +0/-0.5 dB, Line</td>
<td>5 Hz - 75 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-2.0 dB, Line</td>
<td>2.5 Hz - 150 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-0.5 dB, Mic</td>
<td>10 Hz - 100 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-2.0 dB, Mic</td>
<td>5 Hz - 200 kHz</td>
</tr>
<tr>
<td>THD+N (1 kHz), Line/Mic at G=0dB</td>
<td>&lt; -115 dB (0.00018 %)</td>
</tr>
<tr>
<td>THD+N (20 Hz-20 kHz), Line/Mic at G=0dB</td>
<td>&lt; -112 dB (0.00025 %)</td>
</tr>
<tr>
<td>Interchannel Crosstalk @ 1kHz, typ.</td>
<td>-135dB</td>
</tr>
<tr>
<td>5° low-end in-channel Ø deviation pt: Line</td>
<td>13 Hz</td>
</tr>
<tr>
<td>5° low-end in-channel Ø deviation pt: Mic</td>
<td>35 Hz</td>
</tr>
<tr>
<td>Interchannel phase 10 Hz - 100 kHz</td>
<td>&lt; ±0.1°</td>
</tr>
</tbody>
</table>

IOM-H-AD8D/AD8DP Direct Out Section

<table>
<thead>
<tr>
<th>Specification</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency response +0/-0.3dB @ Gain 40dB</td>
<td>10 Hz - 50kHz</td>
</tr>
<tr>
<td>Max Direct Output level typ.</td>
<td>+24 dBu / +13dBu</td>
</tr>
<tr>
<td>Output Impedance (Differential)</td>
<td>&lt; 100 Ω</td>
</tr>
<tr>
<td>Dynamic Range (A-weighted, typ)</td>
<td>133 dB</td>
</tr>
<tr>
<td>THD+N (1 kHz) @ +10dBu</td>
<td>&lt; -120dB (0.0001 %)</td>
</tr>
<tr>
<td>Input Connector Pinout</td>
<td>DB-25 / AES59 (Tascam Ana.)</td>
</tr>
<tr>
<td>Direct Output Connector Pinout</td>
<td>DB-25 / AES59 (Tascam Ana.)</td>
</tr>
</tbody>
</table>

Gain behavior of the Direct Out section

As the Direct Out output is taken just after the Mic-pre analog section, the gain adjustments are not as smooth and linear as after the digital conversion. The figure below shows the behaviour of the gain on the Direct Out (in blue) compared to the gain on the digital side (in red).

Note: on the Direct Out the maximum available gain is + 40.1 dB.
IOM-HORUS-DA8/DA8P

The DA8 (up to 192kHz) and the DA8P (up to DSD) have been shown in testing to be consistently the quietest multichannel D/A conversion modules available anywhere.

IOM-HORUS-DA8/DA8P Key Features
- Auto-mute circuitry for "no-pop" power cycling
- Digitally controlled trims for line up procedures
- Dynamic range of 127dB (typ.)
- Easy to set dip switches for international operating levels

IOM-HORUS-DA8/DA8P Specifications

Max Line Output @ 0 dBFS (jumpers on +24 dBu) +24 dBu +0/-0.5 dB
Frequency response +0/-0.3dB @ fs = 48000 Hz 6 Hz – 20 kHz
Frequency response +0/-0.3dB @ fs = 2.8224 MHz (DSD) NA / 6 Hz – 20 kHz
Frequency response +0/-3.0dB @ fs = 2.8224 MHz (DSD) NA / 2 Hz – 50 kHz
Line Output Impedance (Differential) 100 Ω
Dynamic Range (A-weighted, typ) 126 dB
THD+N D/A (1 kHz) @ 0 dBFS (IOM-HORUS-DA8) < -113dB (0.00022 %)
THD+N D/A (1 kHz) @ 0 dBFS (IOM-HORUS-DA8P) < -115dB (0.00018 %)
Interchannel Crosstalk @ 1kHz, typ. -135 dB
Connector Pinout DB-25 / AES59 (Tascam Ana.)
Line Output Level calibration
The DA8 and DA8P modules feature both hardware level settings and a software fine adjustment to align the Analog Output levels to whatever local/organization operational levels are mandated.

On DA8/DA8P cards from run 7 upwards, the hardware level setting is done via software through the option "max output level" in each DA's setting page, allowing either + 24 dBu or 18 dBu max level.

On DA8/DA8P cards prior to run 7 the hardware level setting is in the form of 4 DIP switches per output channel.

The Hardware settings will usually be set only once, at product installation, and only if the desired Operating Line Level differs from the default ex-factory settings of +18 dBu for 0 dBFS.

Procedure for Hardware alignment (for DA8 prior to run 7):
1. Shut down your Horus and make sure that the Horus back panel Power is also switched OFF.
2. Unscrew all DA8 modules that need adjustment.
3. Pull gently out (5-7 cm is enough) to access the DIP Switches. There is one block of 4 dip switches per channel. Channel 1 is labeled S1, channel 8 is labeled S8.

4. Set the DIP Switches as per the table legend printed on the DA8 module card (run 6 and below)
Output Level calibration Example:
Assuming your operating Level is 21 dBu for 0 dBFS (typical of French Radio Broadcasters), you should set the DIP Switches all OFF (DIP Switch positioned to the left, with respect to the picture below) to set maximum Output Level to +24 dBu (since there is no 21 dBu hardware setting)

Once this is set and the DA modules are screwed back in place. Power up the Horus and go to the Horus Setup Page>Module, select each D/A module for software calibration. In this example case set the software attenuation to -3 dB (see image below), so the overall result ends up at 21 dBu for a Full Scale signal

The Horus software Output Attenuation range is from -12dB to 0dB

How to connect the symmetrical line out to an unbalanced input
Never attempt to short pin 3 (or pin 2) to Ground on Horus DA’s output, since the Horus Line Out driving circuitry is symmetrical but not floating.

Furthermore, as Unbalanced Inputs are traditionally more sensitive than Balanced Inputs, the -6dB Analog level achieved by using only one of the Horus symmetrical outputs, will offer better signal level adaptation with less risks of overdriving the Unbalanced Inputs connected to the Horus.
IOM-H-DA8/DA8P block diagram

**DA8 / DA8P run 1 to run 6**

Digital input → Digital Output Attenuation [0 .. -60dB] → Roll Off Filter → D/A converter → Analog Output Level Selection +12dB/+15dB/+18dB/+24dB → Mute Relay → Analog Output

**DA8 / DA8P run 7 and above**

Digital input → Digital Output Attenuation [0 .. -60dB] → Roll Off Filter → D/A converter → Analog Output Level Selection +18dB/+24dB → Mute Switch → Analog Output
IOM-H-ADA8
These remotely controlled Mic/Line Input and Output cards have broken a new barrier in terms of compactness as well as ultra-low power consumption without compromising on the audio quality. These cards work at sampling rates up to 192 kHz.
Using those combined 8 channel Mic/Line In and Line Out cards allow the Hapi to be configured with up to 16 channels of Analog In/Out.

IOM-H-ADA8 Key Features
- 8 x exceptionally transparent, Swiss designed pre-amplifiers
- Remote/Local switch to Line Level on a per channel basis
- Completely accessible remotely for all parameter changes
- Phantom Power/Phase/Low Cut/Impedance switchable per channel
- Dynamic range of 120dB (A-weighted, typ) on the Line inputs
- Auto-mute circuitry for “no-pop” power cycling
- Digitally controlled output trims for line up procedures
- Dynamic range of 123dB (A-weighted, typ.) on the Line outputs

IOM-H-ADA8 Specifications

IOM-H-ADA8 Mic-Pre + ADC Section
- Mic Pre Max Input (Pad On / Pad Off) +24 dBu / +13 dBu
- Input Impedance (Differential, Software Switchable Per Channel) 2 kΩ / 13.6 kΩ
- Input Impedance with +48V ON (Diff., Soft. Switchable Per Channel) 1.7 kΩ / 6.8 kΩ
- Frequency response +0/-0.3dB @ fs = 48 kHz 10 Hz – 22 kHz
- Frequency response +0/-0.3dB @ fs = 96 kHz 10 Hz – 44 kHz
- Frequency response +0/-0.3dB @ fs = 192 kHz 10 Hz – 85 kHz
- Dynamic Range (A-weighted, typ.), ref +13 dBu 119.5 dB
- Gain Range (software controlled) 0 dB to +66 dB
- Gain Step/Precision 0.5 dB / ±0.2 dB
- THD+N Pre + A/D (20 Hz – 20 kHz) @ -2 dBFS < -102 dB (0.0008 %)
- Interchannel Crosstalk @ 1kHz < -125 dB
- EIN @ >40 dB Gain (150Ω Source Impedance, A-weighted) < -128 dBu
- Common Mode Rejection Rate (20 Hz – 20 kHz) > 60 dB (up to 0 dBFS)
- Phantom Power (Software Switchable Per Channel) +48V
- Phase Reverse (Software Switchable Per Channel) YES
- Low Cut filter (Software Switchable Per Channel) -12 dB/octave, 80 Hz

IOM-H-ADA8 Line input Section
- Max Line Input for 0 dBFS +24 dBu
- Input Impedance (Differential) 13.6 kΩ
- Dynamic Range (A-weighted, typ.), ref +24 dBu 120 dB
- THD+N Line+A/D (20 Hz – 20 kHz) @ -2 dBFS < -102 dB (0.0008%)<br>
- Interchannel Crosstalk @ 1kHz < -125 dB
- Sensitivity Range for 0 dBFS (software controlled) -42 dBu to +24 dBu
- Gain Step/Precision 0.5 dB / ±0.2 dB
- Common Mode Rejection Rate (20 Hz – 20 kHz) > 60 dB (up to 0 dBFS)
- Connector Pinout DB-25 / AES59 (Tascam Ana.)
### IOM-H-ADA8 Mic-Pre Analog Section

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency response +0/-0.5 dB, Line</td>
<td>5 Hz - 75 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-2.0 dB, Line</td>
<td>2.5 Hz - 150 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-0.5 dB, Mic</td>
<td>10 Hz - 100 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-2.0 dB, Mic</td>
<td>5 Hz - 200 kHz</td>
</tr>
<tr>
<td>THD+N (1 kHz), Line/Mic at G=0dB</td>
<td>&lt;-115 dB (0.00018 %)</td>
</tr>
<tr>
<td>THD+N (20 Hz-20 kHz), Line/Mic at G=0dB</td>
<td>&lt;-112 dB (0.00025 %)</td>
</tr>
<tr>
<td>Interchannel Crosstalk @ 1kHz, typ.</td>
<td>-135dB</td>
</tr>
<tr>
<td>5° low-end in-channel Ø deviation pt: Line</td>
<td>13 Hz</td>
</tr>
<tr>
<td>5° low-end in-channel Ø deviation pt: Mic</td>
<td>35 Hz</td>
</tr>
<tr>
<td>Interchannel phase 10 Hz - 100 kHz</td>
<td>&lt; ±0.1°</td>
</tr>
</tbody>
</table>

### IOM-H-ADA8 Line Out Section

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Output level software switchable for 0 dBFS</td>
<td>+24 dBu / +18 dBu +0/-0.5 dB</td>
</tr>
<tr>
<td>Frequency response +0/-0.3dB @ fs = 48 kHz</td>
<td>6 Hz – 22 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-3dB @ fs = 96 kHz</td>
<td>6 Hz – 44 kHz</td>
</tr>
<tr>
<td>Frequency response +0/-3dB @ fs = 192 kHz</td>
<td>6 Hz – 88 kHz</td>
</tr>
<tr>
<td>Output Impedance (Differential)</td>
<td>&lt; 100 Ω</td>
</tr>
<tr>
<td>Dynamic Range (A-weighted, typ.)</td>
<td>123 dB</td>
</tr>
<tr>
<td>THD+N (1 kHz) @ 0dBFS</td>
<td>&lt; -108 dB (0.0004 %)</td>
</tr>
<tr>
<td>Interchannel Crosstalk @ 1kHz</td>
<td>&lt; -135 dB</td>
</tr>
<tr>
<td>Connector Pinout</td>
<td>DB-25 / AES59 (Tascam Ana.)</td>
</tr>
</tbody>
</table>

**IOM-H-ADA8 block diagram**

1. **Analog input**
   - 48V phantom power
   - On / Off

2. **Zin selector**
   - 2kΩ / 6.8kΩ / 13kΩ

3. **Preamp analog gain**
   - 0 to +40dB

4. **Mic / Line pad**
   - -15dB

5. **A/D converter**

6. **Digital gain**

**LINE OUT**

1. **Digital input**
   - Digital Output Attenuation [0 .. -60dB]

2. **Roll Off Filter**

3. **D/A converter**
   - Analog Output Level Selection +18dB/+24dB

4. **Mute Switch**

5. **Analog Output**
IOM-H-PT64
This module allows you to connect your Horus directly to a Pro Tools HD or Pro Tools HDX system through its two Digilink Mini connectors. You can insert up to two modules in a device, meaning you can manage up to 128 Channels at a time. Note that, in Horus, the cards can only be mounted in Slot 3 and Slot 6.
Requires Firmware 3.0.5b28137 and above

IOM-H-PT64 Key Features
• Up to 64 Channels @48kHz per module (32 ch. @ 96kHz, 16 ch. @192kHz)
• Up to two IOM-H-PT64 modules in one Horus/Hapi
• Automatic Delay Compensation
• Three hardware emulation modes (Digidesign 192I/O, HDIO and HDMADI)
• Two Digilink mini connectors

Ports usage
There are two connectors on the IOM-H-PT64 module called Port 1 and Port 2. Working at 44.1/48kHz, both Ports are enabled. Channels I/O 1-32 are carried through Port 1 and channels I/O 33-64 through Port 2. If only 32 channels are needed, it is possible to use both Ports or only one of Port 1 or Port 2 in HD I/O or 192 I/O modes only.
With a Sample Rate of 88.2/96kHz, only Port 1 is enabled. All 32 I/O channels will be carried through this Port.
If the Sample Rate is set to 176.4/192kHz, then all 16 I/O channels will be carried through Port 1 as well.
Port 1 of your IOM-H-PT64 should always be connected to Port 1 on the AVID interface and Port 2 should always be connected to Port 2 even if just one Port is used.

Synchronization and Word Clock
When properly configured, a Horus is able to automatically change its internal clock to match a Pro Tools project’s Sample Rate. The proper IOM-H-PT64 module must be selected in the I/O & Sync menu (PT 3 or PT 6 if module is in Slot 3 or 6). The Auto-follow option must be enabled in Setup -> Format menu, and Horus will change its Internal Sample Rate automatically.
In Pro Tools, the Clock source should be set to Internal for the device emulated by the IOM-H-PT64 module (HD MADI in the following example).

**Sampling Rate mismatch protection**
Audio from Pro Tools to Horus and from Horus to Pro Tools is muted when the Sampling Rate asked by PT is not met by Horus to avoid recording when Sampling Rates mismatch.
Enable the Auto-follow SR option and Synchronize on PT module to avoid any SR mismatch.
**Setups with multiple devices**

Here are a few setups using several Pro Tools Hardware interfaces that need to be synchronized. The other devices present in the setup can be synchronized in several different ways.

If two Horus interfaces are used in a setup, they can be synchronized through the Word Clock connectors. To send the actual Sample Rate, the *Follow SR* option in *Setup -> Format* must be enabled.

The next setup is using Horus as the Master clock for all devices. In this case, the Clock Source must be set to the other device’s Word Clock. The *Follow SR* option in *Setup -> Format* must be enabled.

In the following setup, an external Master Clock is used for all devices. In this case, the external Master Clock controls the Horus Sample Rate. Hence, the external Master Clock must be set accordingly to the Pro Tools project Sample Rate.
Delay compensation
Input and Output delay are strongly dependent on the Hardware. This implies that if one records a single source with two different devices at the same time, one will get two slightly out-of-phase tracks. This is explained by the fact that every device has its own circuitry and different components.
To minimize this issue, Pro Tools implemented an Auto Delay Compensation feature which will automatically shift the recording depending on the Hardware used.
The IOM-H-PT64 module was made to emulate three different Digidesign interfaces and match every interface’s actual input/output latency (within a margin of maximum 3 samples). This chart shows what latency to expect for different setups. Analog/Digital modules latencies are already included in these measures.

<table>
<thead>
<tr>
<th>Emulation Mode</th>
<th>Routing</th>
<th>44k1/48k</th>
<th>88k2/96k</th>
<th>176k4/192k</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Input</td>
<td>-</td>
<td>2* smpl.</td>
<td>2* smpl.</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>-</td>
<td>2* smpl.</td>
<td>2* smpl.</td>
</tr>
<tr>
<td>192IO</td>
<td>Input</td>
<td>From AD8D</td>
<td>65 smpl.</td>
<td>65 smpl.</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>To DA8</td>
<td>24 smpl.</td>
<td>14 smpl.</td>
</tr>
<tr>
<td>HDIO</td>
<td>Input</td>
<td>From AD8D</td>
<td>16 smpl.</td>
<td>12 smpl.</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>To DA8</td>
<td>56 smpl.</td>
<td>21 smpl.</td>
</tr>
<tr>
<td>HD MADI</td>
<td>Input</td>
<td>From MADI</td>
<td>6 smpl.</td>
<td>6 smpl.</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>To MADI</td>
<td>5 smpl.</td>
<td>5 smpl.</td>
</tr>
</tbody>
</table>

* Added to the Input/Output latencies of the modules used

For the delay compensation to be working, it must be enabled in the ProTools software (Options -> Delay Compensation).

Emulation Mode
Configures which Digidesign interface the IOM-H-PT64 module will emulate in Pro Tools. This option does not affect the Horus routing or preamps, it will just set the Input/Output Delays as seen above. When set to None, Pro Tools will see the module as an HD MADI, but Horus will use the minimum latency. Therefore, Delay Compensation will not be accurate on Pro Tools in this mode.

Error AAE -6116
When Horus is configured to follow the Sample Rate asked by Pro Tools, an AAE -6116 error might happen when opening a project with a new Sample Rate. If it happens, click OK to close the error information. Then, when trying to play the file, the error might show again. After clicking OK, the error should not appear again.
If this issue is too frequent, a way to avoid it is to disable the Auto-Follow option in Setup -> Formats and change the Sample Rate on Horus by hand. This should reduce the probability of getting such an error.
IOM-HORUS-MADM/MADS

The MADI Expansion card (MADM - Multimode / MADS – Single mode) doubles the total MADI channel count to 128 inputs and 128 outputs @1FS

HORUS-MADM/MADS Features

- MADI Optical and Coaxial inputs and outputs
- Additional 64 discrete channels of digital input and output (extended mode) at 1FS for a total of 128 inputs and outputs combined with the base unit MADI
- Up to 384 kHz sampling rate
- 24-bit resolution
- Fully compliant MADI (AES 10-1991)
- 2 BNC and 1 SC connectors (Multimode or single mode)

Single mode fibers have a lower power loss characteristic than multimode which means that it supports longer runs but single mode fibers are more expensive. The multimode version (IOM-HAPI-MADM) is the most widely used optical MADI connection, but for fiber lengths of more than 600m Merging Technologies recommends to use the single mode version (IOM-HAPI-MADS).
Horus cables

Connecting the analog audio Input cables to the AD8/AD8P modules

The AD/AD8(P) modules connect the Mic/Line Inputs using DB25 D-SUB connections. Please ensure that the cables you have chosen to use, or have had made, conform to this specification before you attempt to connect them.

![Image showing the connection of analog audio input cables to AD8/AD8P modules]

**Specifications**
- Part: CON-D25-XLRF
- Cable Color: black
- Numbered XLR fan-out
- Cable Ø: 12 mm
- Cable Length: 1,5 m
- Cable Weight: 500 gr

<table>
<thead>
<tr>
<th>Specifications</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-SUB 25 pin</td>
<td>14</td>
<td>1</td>
<td>25</td>
<td>2</td>
<td>13</td>
<td>3</td>
<td>1</td>
<td>4</td>
</tr>
</tbody>
</table>

To connect the D-SUB connection to the IOC-AD8(P), align the Male cable connector with the female D-SUB port on the module. Then, with slight pressure, guide the connector into place. If your D-SUB connector has retention screws on either side, then fasten them finger-tight once the connector has been pushed into place.

**Note:** The pinout of the DB-25 is as per AES59 (Tascam Analog).

* THESE CONNECTIONS ARE NOT MEANT TO SUPPORT ANY SIGNIFICANT WEIGHT.*

Ensure that there is no strain from the connected cable as any significant pressure on the module’s D-SUB connector could damage the Horus unit.
Connecting the analogue outputs cables to the DAB/DA8P modules

The IOC-DA8(P) modules connect the line outputs using DB25 D-SUB connections. Please ensure that the cables you have chosen to use, or have had made, conform to this specification before you attempt to connect them.

<table>
<thead>
<tr>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Part: CON-D25-XLRM</td>
</tr>
<tr>
<td>- Cable Color: black</td>
</tr>
<tr>
<td>- Numbered XLR fan-out</td>
</tr>
<tr>
<td>- Cable Ø: 12 mm</td>
</tr>
<tr>
<td>- Cable Length: 1.5 m</td>
</tr>
<tr>
<td>- Cable Weight: 500 gr</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Out 1</th>
<th>Out 2</th>
<th>Out 3</th>
<th>Out 4</th>
<th>Out 5</th>
<th>Out 6</th>
<th>Out 7</th>
<th>Out 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pin 24 (−)</td>
<td>Pin 12 (−)</td>
<td>Pin 21 (−)</td>
<td>Pin 7 (−)</td>
<td>Pin 16 (−)</td>
<td>Pin 6 (−)</td>
<td>Pin 4 (−)</td>
<td>Pin 1 (−)</td>
</tr>
<tr>
<td>Pin 23 (−)</td>
<td>Pin 22 (−)</td>
<td>Pin 9 (−)</td>
<td>Pin 20 (−)</td>
<td>Pin 3 (−)</td>
<td>Pin 14 (−)</td>
<td>Pin 13 (−)</td>
<td>Pin 11 (−)</td>
</tr>
</tbody>
</table>

GND is connected to Pins 2, 5, 8, 11, 14, 19, 22, 25. Pin 13 is not connected

To connect the DSUB connection to the IOC-DA8(P), align the Male cable connector with the female DSUB port on the module. Then, with slight pressure, guide the connector into place. If your DSUB connector has mounting screws on either side, then fasten them finger-tight once the connector has been pushed into place.

Note: The pinout of the DB-25 is as per AES59 (Tascam Analog).

* THESE CONNECTIONS ARE NOT MEANT TO SUPPORT ANY SIGNIFICANT WEIGHT.*

Ensure that there is no strain from the connected cable as any significant pressure on the module’s DSUB connector could damage the Horus unit.
Connecting the AES-EBU cable

The AES ports connect the AES-EBU I/O using DB25 D-SUB connections. Please ensure that the cables you have chosen to use, or have had made, conform to this specification before you attempt to connect them.

![Cable Diagram]

**Specifications**
- Part: CON-D25-XLRD
- 192 kHz ready
- Cable Color: black
- Impedance: 110 Ohm
- Numbered XLR fan-out
- Cable Ø: 12 mm
- Cable Length: 1.5 m
- Cable Weight: 500 gr

To connect the DSUB connection to the AES port, align the Male connector with the female DSUB port on the module. Then, with slight pressure, guide the connector into place. If your DSUB connector has mounting screws on either side, then fasten them finger-tight once the cable has been pushed into place.

**Note #1:** The pinout of the DB-25 is as per AES59 (Tascam Digital).
**Note #2:** Users that have Mykerinos AES or Dual cables cannot use those with their Horus or Hapi as the pin out is not compatible.
**Note #3:** DB25 TDIF cables are not compatible with Horus/Hapi AES

*THESE CONNECTIONS ARE NOT MEANT TO SUPPORT ANY SIGNIFICANT WEIGHT.*
Ensure that there is no strain from the connected cable as any significant pressure to the module’s DSUB connector could damage the Horus unit.
Connecting the MADI cable

The MADI port (both the standard one and the optional MADI Expansion module) can be connected using either Optical or coaxial cabling.

When using Optical cabling, first ensure that you have a clean work area, as dust and debris can affect the connection if any obstruction is present. Remove the cap on both the cable and the port and slowly / firmly push the cable into the receiving port on the Horus unit until it clicks into place. The MADI optical connector is available in Multimode or Single mode versions. The Horus is delivered with Multimode connectors unless specified at ordering.

When using a Coaxial connector, slowly bring the Male cable up to the female port, ensuring that the pin in the centre of the male cable lines up with the receptacle in the female port. Push the connector firmly into place and twist the sleeve clockwise until it clicks into its locked position. Maximum recommended cable length is 100 meters.

Connecting the Wordclock input/output

The Wordclock connections on the rear of the Horus unit are coaxial BNC’s. To connect a wordclock source from an external device slowly bring the Male cable up to the female port, ensuring that the pin in the centre of the male cable lines up with the receptacle in the female port. Push the connector firmly into place and twist the sleeve clockwise until it clicks into its locked position.

Connecting the Sync Cable

The Sync Cable (optional with each Horus unit) is a DB15 cable that connects to the “SYNC” port on the rear of the Horus unit. The SYNC cable provides connectivity for LTC and Video Reference Input and Output for the Horus unit. To attach this cable to the Horus unit, align the male connector with the female DBSUB port on the module. Then, with slight pressure, guide the connector into place. Once the cable has been pushed into place, fasten the mounting screws on either side finger-tight.
Sync breakout cable pin-out

MIDI connection:

In order for the MIDI support to be functional the Dip switches 1 and 2 on the Ethertube board must be switched to OFF. For more details refer to the use of Horus MIDI Din chapter below.

Note: As of the Horus/Hapi serial number H80730/H90620 jumpers already have the factory configuration for MIDI support

Connecting the RAVENNA Ethernet cables

The RAVENNA ports (Primary and Secondary) are RJ45 female receptacles. Simply line up the RJ45 cable with the slot on the rear of the Horus unit and slide it into place until it clicks into its locked position. (Category 5E or 6)

Note: Only primary (PRI) port should be used for now (Secondary port is for network redundancy and not yet supported)
Horus key features

Modular analog interfacing
Horus allows the user to choose how many Analog inputs and Analog outputs are required for each unit. Horus provides a total of six universal I/O slots which can accept a combination of Mic/Line modules and/or Line output cards. Users can configure their Horus with any combination but installing more than 3 Mic/Line modules requires the installation of the Horus Redundant Power option. For instance, in a studio environment, 24 A/D (3x IOC-ADB/P) and 8 D/A (IOC-AD8/P) will allow for 24 inputs from the live room and 8 outputs to feed studio monitoring and foldback to the artist. But, with any combination being possible, this is but one of many scenarios for different combinations.

Modular Device connectivity
Any of the modules listed below (A/D, D/A, MADI, AES, RAVENNA) can be interconnected in any way the user chooses. Simple and easy routing pages enable the user to source signal from any module, and send it to any other combination of modules. An A/D Module could feed 8 Channels of AES Outputs. At the same time, it could feed to 8 MADI channels, or even the RAVENNA stream as well. This is the function that allows the user operate with the Horus in either a standalone (Analog to MADI/AES AD/DA) or in RAVENNA Mode, which connects the audio to a RAVENNA network (described below).

With such a wealth of different outputs, it made sense to apply a “route to” instead of a “route from” philosophy in the way Horus presents its routing pages. After an initial learning period, you will understand that this is a much more efficient way to present so many routing options in an easy to unfold process. So always ask yourself first which output is being considered and then decide what input signal will feed that output and you will be offered all logical and valid choices at every step. It also made sense to limit the granularity of routing options to blocks of 8 channels, as a good compromise between flexibility and complexity.

AD8 / AD8P Remote controlled Mic/Line A/D module
The AD8 (works up to 192 kHz) and the AD8P (works up to DXD/DSD256) are remote controllable, extremely high-quality Microphone pre-amplifiers with a switch on each channel to route the signal through dedicated line level circuitry instead. The remote control is achieved over Ethernet, via the RAVENNA Port at the back of the chassis. With all standard analogue controls also available via remote (Phantom power on a “per channel” basis, phase invert, HPF) and a Gain stage reaching from -10dB all the way up to +60dB, these modules are not only easy to use, but completely transparent to listen to as well.

DA8 / DA8P Safety Conscious Analogue Line output Modules
The DA8 (works at sample rates up to 192 kHz) and DA8P (works at sample rates up to DSD) are specifically designed with the user’s speakers in mind. Incorporating analogue mute circuitry, the DA8/P modules provide protection against spurious transients that may occur during Sample rate changes and power cycling “clicks” and “pops” which can damage not only speakers, but also the listener’s ears. When you add to that a noise floor of less than -125dB, these are the ultimate analog outputs for any monitoring system.

ADA8 Remote controlled Mic/Line A/D module with transparent Analog output
The ADA8 work at sample rates up to 192 kHz.

HD Link with Pro Tools HD
The PT Module allows the Horus to communicate with a Pro Tools HD card. With two modules in one interface, up to 128 channels can be recorded simultaneously.

Redundant power supply options
In broadcast and live applications, nothing can be allowed to fail. By requesting the addition of the optional redundant power supply to be configured with your Horus interface, you can insure against the possibility of power supply failure. The redundant power supply takes up no more room and only adds a few grams to the unit’s total weight.

Redundant versus secondary Power supply (More than 3 Analog Input modules)
There are two configurations for the Horus Redundant / Secondary power supply.

1- Standard redundancy: With two AC power inlet connectors in case of a power failure.
Note: If there are more than 3 AD Modules (up to a maximum of 6 AD or 6 ADA). Both power supplies will have to be physically connected at all times.

2- **Secondary power supply:** If more than 3 AD or 3 ADA cards are specified at Horus order time, Merging will configure the Horus with a Secondary power supply in order to provide ample current reserve at Power up and during normal operation with many phantom powered microphones. In that scenario Horus is wired to only use one AC Power inlet connector.

*Note: Do not remove the power sticker on the second covered up inlet power.*

**MADI 1**
This MADI port (switchable between coaxial or optical input connections using the front panel Touch Screen) provides users with up to 64 channels of MADI I/O for use with the system. The signal sent to the MADI Outputs (both Coaxial and Optical are available simultaneously) are configurable in blocks of 8 channels and can be sourced from any other module in the Horus.

**MADI 2 (Expansion Slot)**
An expansion slot allows a second MADI card to be fitted into the Chassis, bringing the total MADI I/O up to 128 channels. When using the RAVENNA connection to deliver sound to your Pyramix or Ovation system, this increases the total possible Inputs and outputs in a single Pyramix/Horus combination to a mind-boggling 176 x 178 channels (combined Analogue/AES/MADI).

**AES-EBU**
3 x D-SUB25 connectors providing 24 channels (12 AES pairs) of AES-EBU I/O are included as standard (as is the MADI 1 module).

**Signal routing paradigm**
Horus is quite possibly the most flexible audio interface ever designed. Users can literally route any input signal to any output module. Better yet, it can route any input signal to any combination of output modules. Routable in blocks of 8 channels, a user can send 8 Mic Inputs to 8 AES outputs. At the same time these 8 mic inputs can also be sent via the MADI outputs and included in the RAVENNA stream.

**RAVENNA IP Audio**
Using RAVENNA IP audio, Horus can connect to a standard network, using off the shelf switches and other IT technology to become a node on a LAN. From that point, any other RAVENNA node can receive information from and deliver information to, any combination of RAVENNA devices on the network. It is a revolution in Audio technology and will soon mean the end to costly audio routers and matrices and allow any facility an immense amount of flexibility. From Broadcast and TV/Film post-production, to music, live events, theatres, cruise ships and many more applications, the RAVENNA Enabled Horus interface will reinvent how systems come together.

**Synchronization**
Audio is not the only information that can pass down the RAVENNA connection. Horus is also able to send sync (LTC) down the same wire to and from the Hapi unit. For more details refer to the RAVENNA network guide available on [www.merging.com](http://www.merging.com).

**Key Specifications**
Please see the sections below for the measurement performed on the circuitry inside the Horus unit.
### Horus Modules Capabilities

<table>
<thead>
<tr>
<th>Sampling Rates</th>
<th>Modules</th>
<th>AD8 standard</th>
<th>AD8D standard</th>
<th>AD8P standard</th>
<th>AD8P premium</th>
<th>AD8P premium</th>
<th>PT64</th>
<th>Headphone</th>
<th>MADI</th>
<th>AES</th>
</tr>
</thead>
<tbody>
<tr>
<td>44.1/48kHz</td>
<td>44.1/48kHz</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√ (64 I/O)</td>
<td>√</td>
<td>√ (64 I/O)</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>88.2/96kHz</td>
<td>88.2/96kHz</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√ (32 I/O)</td>
<td>√</td>
<td>√ (32 I/O)</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>176.4/192kHz</td>
<td>176.4/192kHz</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√ (16 I/O)</td>
<td>√</td>
<td>√ (16 I/O)</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>DXD/384kHz</td>
<td>15 smpl.</td>
<td>16 smpl.</td>
<td>2 smpl.</td>
<td>15 smpl.</td>
<td>3 smpl.</td>
<td>3 smpl.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The Headphone gain slider for level adjustment is not supported

### Horus Modules Latencies

<table>
<thead>
<tr>
<th>Sampling Rates</th>
<th>Modules</th>
<th>AD standard premium</th>
<th>AKD8 standard premium</th>
<th>DA Input Output</th>
<th>PT64</th>
<th>Headphone</th>
<th>MADI</th>
<th>AES</th>
</tr>
</thead>
<tbody>
<tr>
<td>44.1/48kHz</td>
<td>44.1/48kHz</td>
<td>15 smpl.</td>
<td>12 smpl. *</td>
<td>16 smpl.</td>
<td>2 smpl.</td>
<td>15 smpl.</td>
<td>3 smpl.</td>
<td>3 smpl.</td>
</tr>
<tr>
<td>88.2/96kHz</td>
<td>88.2/96kHz</td>
<td>8 smpl.</td>
<td>12 smpl.</td>
<td>12 smpl.</td>
<td>2 smpl.</td>
<td>8 smpl.</td>
<td>3 smpl.</td>
<td>3 smpl.</td>
</tr>
<tr>
<td>176.4/192kHz</td>
<td>176.4/192kHz</td>
<td>8 smpl.</td>
<td>9 smpl.</td>
<td>12 smpl. *</td>
<td>13 smpl.</td>
<td>8 smpl.</td>
<td>3 smpl.</td>
<td>3 smpl.</td>
</tr>
</tbody>
</table>

* DA Filter setting
- Slow Roll Off Filter option = 12 Samples
- Sharp Roll Off Filter option = 39 Samples
(More details available under the DA Module chapter below)

** ADA Filter setting
- Slow Roll Off Filter option = 9 Samples
- Sharp Roll Off Filter option = 38 Samples
Installing an additional Horus I/O Module

Installing additional Horus I/O Cards (AD8/AD8P/AD8D/AD8DP/AKD8D/AKD8DP/ADA8 or DA8/DA8P)

Before you start
- Place the Horus unit on a hard, dry surface or mount it onto a 19" rack and leave plenty of room for air convection.
- In order to meet the EMC requirements of directives 89/336/EEC and 93/68/EEC, and in order to obtain the high performance possible for the Horus unit, you must use correctly shielded cables of good quality for all external connections when installing the Horus unit. For the power connection, a normal unshielded power cable with a proper ground can be used.
- Make sure that your sound system is at a safe volume level.

Hardware Installation
This section will take you through installation of your Horus unit. We will describe how to mount the I/O modules and the power, audio and digital cable connections that can be accessed on the rear panel.

*PLEASE ENSURE THAT YOUR HORUS UNIT IS SWITCHED OFF BEFORE ATTEMPTING TO CONNECT ANY CABLES TO THE UNIT.*

If you need to mount an I/O module at a later stage, the following procedure is used.

1. Place the shutdown Horus unit on a dry steady horizontal surface. Remove all cables (including the power cable).
2. On the back of the Horus unit there are 6 slots for mounting the Analog I/O cards. While all 6 slots are equivalent internally, the 3 top slots are preferable for the AD8 or AD8P Mic/Line input modules and the lower 3 for the DA8 or DA8P line output modules. On the drawing above, they are marked as blind Plates for I/O module slots.
3. The PT64 cards can only be mounted in Slot 3 and Slot 6.
4. To remove blind plates from I/O module slots, remove the 2 screws on either side of the plate. Use a Phillips (cruciform) screwdriver tool size 2
5. Only remove the number of blind plates necessary to fit the I/O module(s). If only one I/O slot is installed, remove only 1 blind plate. If 2 I/O slots are installed, remove 2 blind plates.
6. It is very important to insert the I/O card horizontally and carefully into the Horus unit. There are 6 set of guides inside the Horus unit to guide the I/O cards correctly into place. Do not use force in any way to insert the I/O card. This may damage the card. Slide card slowly as picture below shows.

![Image of I/O card installation](image)

7. When the cover plate of the I/O card covers the hole created by removing the blind plate, the 2 screws from the blind plate are mounted in the sides of the I/O card. Tighten the screws carefully and be careful not to damage the threads.
8. After inserting the I/O module, the Horus unit might need to be initialized. If this is the case, please follow the instructions received with the I/O module.
Installing an additional Horus MADI Extension Module (MADM or MADS)

Before you get started
- Place the Horus unit on a hard and dry surface or mount it into a 19” rack and leave plenty of room for air convection.
- In order to meet the EMC requirements of directives 89/336/EEC and 93/68/EEC, and in order to obtain the high performance possible for the Horus unit, you must use correctly shielded cables of good quality for all external connections when installing the Horus unit. For the power connection, a normal unshielded power cable with a proper ground can be used.
- Make sure that your sound system is at a safe volume level.

Hardware Installation
This section will take you through installation of your Horus unit. We will describe how to mount the I/O modules and the power, audio and digital cable connections that can be accessed on the rear panel.

*PLEASE ENSURE THAT YOUR HORUS UNIT IS SWITCHED OFF BEFORE ATTEMPTING TO CONNECT ANY CABLES TO THE UNIT.*

Installing Horus MADI Extension I/O procedure
The MADI extension packaging includes the MADI module along with; two BNC nuts, two BNC washers, two spacers and two screws.

1. Place the Horus unit on a dry steady horizontal surface. Remove all cables (including the power cable) and unscrew the Horus top panel.

2. On the Back Panel unscrew the MADI cover plate above your current MADI 1 I/O Module
3. Open the Horus top panel, remove the AD8/AD8P or D/A8/DA8P modules that could be obstructing access to the MADI module.

4. Disconnect the ribbon cable carefully

5. Screw the 2 spacers onto the MADI 1 / AES board

6. Slide the MADI extension board carefully so that the output connectors emerge from the Horus back panel. You will need to do this at an angle that will allow you to push and fit the connector into the header of the MADI 1 card (below). Align and push the MADI extension board gently so that it fits into the header.
7. Secure the MADI extension using the 2 screws provided

8. Re-connect the Ribbon cable

9. Place the 2 washers and screw the 2 nuts onto the I/O BNC connectors at the back of the Horus MADI Extension card

10. Replace any modules that were removed earlier to provide access

11. Close the Horus top panel cover and replace the fixing screws

12. Power the HORUS back on and the MADI 2 module will be recognized
Installing the Merging PCIe Ethernet Controller Card
NET-MSC-GBEX1

Detailed steps on how to install the NET-MSC-GBEX1 PCIe card in your PC.

1. Power down your PC and switch it off at the wall. Remove the screws holding the top or side of the case on and carefully slide off the panel.

2. Wearing an anti-static wristband is desirable whenever working with sensitive electrical equipment. Keeping one hand on a metal part of the case will have the same effect, though you may need both hands when installing certain items of hardware.

3. Locate an empty PCIe slot and remove the metal backing plate by removing the screw holding it in place and carefully sliding it up and out. In some cases, there are no backing plates and you will need to remove a length of metal instead. Do this using a flat-blade screwdriver and/or pliers, taking care to avoid any sharp edges left behind.

4. Next, remove the NET-MSC-GBEX1 card from its envelope bag and line it up with the vacant PCIe slot as shown below.
5. Push down gently at first, ensuring you have the pins lined up correctly with the slot, and then apply more force to slot the card home fully.

6. Use the screw which held the backing plate in place to secure the card and check that the card sits properly. Finally, replace the case cover(s) and plug your machine back in.

6. At “First Power Up” Windows will discover the Merging Ethernet PCIe card

Note: Refer to the Merging RAVENNA Configuration Guide for more details on the Pyramix MassCore-RAVENNA setup
Horus recommended placement in Rack

Due to confined space in a Rack furniture, adequate spacing (and ordering) between multiple Horus units will play a significant role on the units temperature. Although Merging has spent considerable time in optimizing the Horus power consumption in every aspect possible, the units are still drawing an average of 35W to 45W each. The dissipation of the related heat produced by this consumption is therefore highly dependent on the airflow and natural air convection around those units.

With highly loaded Horus units (more than 3 I/O Analog modules per unit), Merging recommends a free space of 1U above each unit to ensure adequate cooling of the devices, if no other heating elements are present.

Horus power ON

Connecting the Power Cable
The Horus unit runs on 85-240V, 50-60 Hz AC voltage. Excessive voltages can seriously damage the Horus unit, so make sure that your AC power matches the voltage of your Horus unit. When you connect the power, use the cable you received with your Horus unit and plug it into a grounded outlet. For safety and EMC reasons, and to prevent audio hum, the system must be properly grounded. If your power source does not have a standard three-prong socket, the system must be grounded in another appropriate manner.

If your Horus unit is equipped with the Redundant Power Supply option, make sure you connect both mains cables (one to PRI and one to SEC mains plugs on the Horus).

1. Ignite the Horus Back Panel Power Switch

2. Press the Horus Front Panel Power Button

3. The Horus front panel button will turn blue. If the panel button light isn’t steady but appears to flicker, this may indicate a fault condition and requires immediate shut down.
4. Wait until the Horus is fully started and displaying the Main Home screen.
Horus touch screen control interface

Horus Menu Hierarchy

HORUS MENU HIERARCHY

HOME

USAGE PARAMS
Monitor  I/O & Sync  Meters  PreAmp (TFT)
Refs  TimeCode  Meters Settings  PreAmp (Web)

SETUP & CONFIGURATION
Formats  Routing  Modules  Presets  Advanced Setup
MADI  AES  AD  DA  Network
Main Home Screen
This is the screen which you will see after the Horus completes its boot sequence. From here you can navigate to all the other menus for the setup and use of Horus. If at any time you want to return to the Main Screen, you can press the Merging Logo in the bottom left-hand corner to return to the Main Screen. The screen also has access to the 5 main sections of the Horus menu: **Headphone, Meters, IO & Sync, PreAmp and Setup**.

![Main Home Screen](image)

Headphone Menu
The Headphone menu refers to the Horus front panel Headphone Monitor jacks. The Headphone jacks 1 & 2 (6.3 mm and 3.5 mm) output the same source and level.

![Headphone Menu](image)

- **Headphone Gain**: Sets the gain of the Headphone output. Use the slider (Left= less gain / Right= more gain) or the + - buttons to set the gain to the desired level
  
  - Headphone level range: -60 dB to +12 dB

- **Headphone Mute**: Mutes the headphone output when OFF is active

- **Output Source**: Shortcut to the Output Source Page for the Headphone module (Described below in “Modules Sub-Menus section”)

- **Channel selector**: The Headphone (Monitor) being a Stereo output it is possible to select which pair of channels you want to Headphone (1-2, 3-4, 5-6 or 7-8)
**Meters Menu**

The Meters menu will display the input metering of the modules present in the Horus.

LED indications:
- Peak indication
- Alignment range
- Signal indicator

The LEDs indicate the inputs levels of the AD1 inputs 1 to 8.
*Note: You can reset a module Peak by pressing the Module display. In the example above pressing A/D 1(8ch) will reset the peak displayed on the input 1.*

**Meters Settings Menu**

```
<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hot</td>
<td>-0.2 dB</td>
</tr>
<tr>
<td>Alignment</td>
<td>-18 dB</td>
</tr>
<tr>
<td>Decay Int. Time</td>
<td>25 ms/dB</td>
</tr>
<tr>
<td>Peak Hold</td>
<td>On</td>
</tr>
</tbody>
</table>
```

- **Hot:** Sets the level above which the meter display will be red. If set to 0dB this will mean clipping. Range -2dBFS to 0dBFS
- **Alignment:** Sets metering level alignment range (yellow leds). Range -24dBFS to 0dB
- **Decay integration time:** Sets the rate at which the level meter display decays after the level falls below the most recent Peak.
- **Peak Hold:** If ON it will keep the red Peak Hold Overload in display
IO & Sync Menu

The IO and Synchronization menu is where the user can select the source of the Horus reference clock. It is essential that these settings are configured correctly in order to ensure a clean audio signal through the Horus unit.

Reference Source
Choose the desired sync source by pressing on the respective Reference source. Available Reference Sources are: MADI, Sync or AES

Reference navigation
Selecting a Reference with multiple choices (such as Sync or AES) will enable the source navigation. The navigation is performed from top to bottom and will cycle through in this order at each consecutive press. The selection of another Reference Source will re-select the top entry in the list by default.

PTP Clock
The Precision Time Protocol (PTP) is a protocol used to synchronize clocks throughout a computer network. Also known as IEEE 1588, it is a protocol designed to synchronize real-time clocks in the nodes of a distributed system that communicates using a network RAVENNA is based on and uses V2 of this IEEE standardized protocol. PTP Clocks allow for time resolution to the Nanosecond.

Master: indicates that the current Horus is the PTP Master
Slave: The Horus is slave to another PTP Master

The Horus will always try to be the PTP Master. If multiple Horus’ are used in a network environment, the Horus set in this order will have the PTP Master priority, using the Best Master Clock Algorithm (BMCA):
1. Video sync
2. Word Clock
3. AES
4. SPDIF
5. MADI
6. PT64 Module
7. Internal
8. RAVENNA (always slave unless there is no PTP master available)

Sync Color table:
- Dark Blue: Signal present
- Light Blue: Signal valid
- Black: No Signal
- Red: Unlocked
- Yellow: Locking
- Green: Locked

Note: When two or more Horus are connected together through an Ethernet network, one of them will always be automatically selected as master, the other Horus’ will be forced into slave state and therefore will not be synchronized to wordclock or audio input. However, this is not a problem since all Horus’ will be synchronized.
Status: LTC IN: Corresponds to the incoming LTC frame rate

Horus PTP status: MASTER or SLAVE

Video Format Detected:
Supported Formats:
PAL – NTSC
720p50 – 720p59.94 – 720p60 (not recommended video formats)
1080i25 – 1080i29.97 – 1080i30
1080sf25 – 1080sf29.97 – 1080sf30

Timecode Menu (I/O & Sync)

IN Timecode: Will display the current incoming LTC/Timecode

OUT Timecode: Will display outgoing LTC/Timecode

Frame Rate: The current LTC/Timecode Frame Rate is indicated next to the Timecode IN & OUT display

From: Indicates the Timecode provider (in example above the Pyramix DAW)

Timecode Level: Shows the current LTC output level in dBu. The selector offers a choice of output level from -18dBu to +9dBu in 3dBu increments, or can be switched off

Mute on Stop: If OFF the LTC output will not be active (default)
If ON the LTC output is generated constantly
**REFS Menu (I/O & Sync)**

This Sub Page menu is where you can view the Deviation and Jitter of the External Reference, as measured by the Horus synchronization circuitry.

![REFS Menu](image)

**Frequency:** The long-term measured Frequency (in Hz) and deviation in ppm (parts per million) between the signal the unit is locked on to and the internal reference.

**Delta:** The short-term (instantaneous) time offset between the reference signal and the internal (considered as ideal) reference, measured in nanoseconds (ns). In other words, the delta indicator over a RAVENNA network will report the delta in ns between the master and the slave.

**PreAmp Menu**

The PREAMP (A/D) menu becomes active if you have 1 or more AD8(P) modules installed in the Horus unit, giving full access to the Input controls. Please see below for a description of the buttons available.

![PreAmp Menu](image)

**All**

- **Active:** Will select all 8 input channels for function and level grouping
- **Inactive:** Adjustments to the input settings and level affect only the selected channel only

Note the All button will group all inputs of the same type (Mic or Line)
Gain Slider

The + or - buttons give increments/decrements in 0.5 dB steps. Slider range goes from 0 dB to +66.0 dB from left to right.

In Mic mode: Sets the Mic Preamplifier’s Gain. In Line mode: Sets the Line Input Sensitivity. A value of 0 dB corresponds to an input sensitivity of +24 dBu for 0 dBFS. This corresponds to a calibration level of +4 dBu for -20 dBFS. A value of +20.0 dB corresponds to an input sensitivity of +4 dBu for 0 dBFS. A value of +66.0 dB corresponds to an input sensitivity of -42 dBu for 0 dBFS.

Example: Assuming you want to interconnect to an analog console and your standard studio alignment level is +4 dBu for -18 dBFS. In this case set the gain slider to +2 dB. Similarly on the DA analog output side, set the attenuation to -2 dB, refer to section Line Output Level calibration on page 20, provided the max output level is set to +24 dBu.

Mic or Line

Switches the Input from the Mic-Pre amplifier to the Line level circuitry. The button will show the current input signal path it is set for (Mic or Line). The Line input sensitivity can be adjusted by setting the line gain for each input of the AD module.

Line Fader of -20 dB, means 0 dBFS for +24 dBu Analog signal level present at the Line input.
Line Fader of + 6 dB, means 0 dBFS for +18 dBu Analog signal level present at the Line input.
Line Fader of + 20 dB, means 0 dBFS for +4 dBu Analog signal level present at the Line input.
Line Fader of + 66 dB, means 0 dBFS for -42 dBu Analog signal level present at the Line input.

Note #1: the MIC and Line inputs are stored as independent parameters, meaning that switching from Mic to Line and vice versa will load its own gain (sensitivity) value.

Note #2: The Premium AD converters of Horus have been designed in order to be able to benefit from the +3.1 dB SA-CD headroom offered by DSD, as per the scarlet book standard. Therefore a minimum of 46 dB gain is required on the Mic preamp or line input. This gain is applied in the digital section post AD just prior to the sigma delta 1-bit modulator. It is automatically applied as soon as the ADs are switched to DSD (64, 128, 256FS) and is visible in the preamp page. The gain can be adjusted between 6 dB and +66 dB in DSD mode. In Line mode, with a gain of +6 dB, an input of +21 dB will generate a signal of +3 dB SA-CD, in Mic mode, with the same gain, an input of +10 dB would generate a signal of +13 dB SA-CD.

To benefit also from this +6 dB headroom in DSD on the DA outputs, we recommend our users to set the Output Attenuation to -6 dB on each DA module configuration page.
48V  
This button will turn on 48V phantom power for the channel. If it is lit, it means that Phantom power is active. Only active on channels set to Mic.

The total current drawn on the phantom power by all the microphones should never exceed 150mA for the whole device

This warning applies ONLY to the initial RUN 3 production batch of AD8 and AD8P and has been fixed for all modules shipped starting November 2012: The 48V power MUST be turned off prior to changing the connection in certain patch bays. Many such patch bays do short the Hot, Cold or both signals to Ground during insertion or removal of the Jacks with the risk of deteriorating permanently the protective resistors in the input of the PreAmp circuitry. If an AD module input circuitry is damaged, following such a short, it will end up permanently having inaccurate gain levels, distortion or even no signal at all on some channels. That would require hardware replacements at your own cost, since such damage is not covered by our warranty.

If you still own one of the original and unmodified RUN 3 AD8/AD8P modules we recommend that you contact your Merging reseller to organize an update of your module(s), which Merging is pleased to provide free of charge.

Zlo – Zhi  
Mic input impedance (only available for ADA8, AKD8D/AKD8DP & AD8D/AD8DP run 9 and above modules)

For the different mic input impedance values, please refer to the card specifications.

PAD  
A -10 dB Pad can be applied in the Mic Preamp circuitry.

Ø  
Phase invert button. When lit, it inverts the polarity of the selected input signal.

80 Hz  
Low cut filter 80 Hz. Second order, 12 dB/octave.

Meters dB scaling  
The Meters scaling is displaying from -90 dBFS to 0 dBFS.

Meters color range  
Refer to the Meters Page Settings, in order to adjust the Level meter color range (Peak, Alignment and Decay time).

Rst  
Stands for Reset Peaks Hold Meters. The top Red led of the PreAmp metering will indicate that a Peak has occurred. In order to clear the Peak display, simply press the RST button. This is useful if you have enabled the Peak Hold option under the Meters menu Settings

Navigation  
Use the left << and right >> arrows in order to navigate through the banks of 8 inputs Will be active if more than one AD8(P) module is present in the unit.
Setup Menu

The Setup menu’s primary page contains function buttons described below as well as sub-menu links listed in the sub-sections: Formats, Routing, Modules, Presets, System, Network and Info

Setup

Shutdown: Initiates a proper shutdown of the Horus unit, including a save of the current configuration. Do not attempt to shutdown the Horus unit in other ways (such as using the power switch on the back of the device).

Reboot: Power cycles the Horus unit (shutdown>Boot up)

Reboot maintenance: Power cycles the Horus unit (shutdown>Boot up) and restarts in Maintenance mode (required mode for Firmware upgrade)

Reboot to Factory: If selected we will reboot the Horus to the default factory configuration. The Current configuration will be lost but all the saved presets will be kept and can be reloaded.
**Formats Menu (Setup)**

**Sample Rate:**
Select the Horus Sampling Rate
44.1 kHz - 48 kHz - 88.2 kHz - 176.4 kHz - 192 kHz - 384 kHz – DXD/DSD
Note: The available Sampling Rates depend on the Horus Analog module cards. Only Premium Analog modules offer support beyond 192 kHz.

**Auto**
Auto Sampling Rate mode. Horus will automatically follow the sampling rate given by a RAVENNA source (provided by: ASIO/Virtual Audio Device (formerly Core Audio Driver), MassCore or another Hours/Hapi) or external Input/Sync Source.

Example 1: User using an external player (such as jRiver) can enable the Auto mode so that Horus automatically changes its sampling rate according to the media file being played back.
Provided at least one RAVENNA ASIO or Virtual Audio Device (formerly Core Audio Driver) stream is connected to an Output of the Hours/Hapi.

Example 2: This Auto setting can apply to user running the RAVENNA ASIO/Virtual Audio Device (formerly Core Audio Driver) so that Hapi adapts its sampling rate automatically.
Provided at least one RAVENNA ASIO or Virtual Audio Device (formerly Core Audio Driver) stream is connected to an Output of the Hours/Hapi.

Example 3: Another usage of this « Auto » sample rate button is to enable the Hours/Hapi locked (e.g. WordClock) to automatically follow the sample rate of the WordClock generator (same applies to AES/ADI/ADAT sync).
Provided at least one RAVENNA ASIO or Virtual Audio Device (formerly Core Audio Driver) stream is connected to an Output of the Hours/Hapi.

Warning: The Auto sampling Rate option must be disabled if locking the Hours/Hapi devices to reference (e.g. 44.1kHz WordClock) which would be different than the working Sampling Rate Format (E.g. 88.2kHz, 192kHz, DXD..)

**A/D Mode in DXD/DSD:**
This format setup only applies to the AD module which can be set to either DXD - DSD64 - DSD128 - DSD256.
Note: The Horus can be configured in DXD/DSD and in this mode the Horus can receive any audio data format stream and can generate DXD or DSD(64, 128 or 256) stream depending on the A/D audio data format chosen.

**WordClock Output:**
44k1 / 48k: When enabled the Wordclock Output will be at either 44.1kHz or 48kHz.
Example:
Sampling Rate: 44k1/88k2/176k4 the WordClock Output will be 44.1kHz
Sampling Rate: 44k/96k/192k the WordClock Output will be 48kHz.

Follow SR: When enabled the WordClock Output will follow the Sampling Rate selected.
Example:
If the selected Sampling Rate is 48k the WordClock output will be at 48kHz
If the selected Sampling Rate is 176k4 the WordClock output will be 176.4kHz

Pull Up/Down: Slow down or accelerate audio clock by 0.1 % depending on the frame rate of the video reference.
This option will only be active if the sync source is configured to Video Ref.
The Status of this option can be viewed in the IO&Sync page under Status
- Off: Normal operating mode
- Up: Accelerate the clock by 0.1%. Supported only with a Video reference at 24fps and 30fps
- Down: Slow down the clock by 0.1%. Supported only with a Video reference at 23.98fps and 29.97fps

Routing Menu (Setup)

Routing menu describes where the signal for each module in the Horus is coming from. Each button leads to a sub-menu that allows the user to change the source of the signal to that specific module. For instance, the Headphone Button in the Routing menu will allow the user to change the routing to the Headphone.
Choices are made in blocks of 8 channels (except for the Headphone, which is a Stereo signal).

- Headphone: Takes you to the Headphone Routing configuration page (refer below)
- MADI 1: Takes you to the MADI 1 Routing configuration page (refer below)
- MADI 2: Takes you to the MADI 2 Routing configuration page (refer below)
- D/A: Takes you to the D/A Routing configuration page (refer below)
- PT: Takes you to the PT Routing configuration page (refer below)
- AES: Takes you to the AES Routing configuration page (refer below)
- A/D: Disabled as one cannot route TO an Input!
- Loopback: Takes you to the Loopback module (present only in debug mode)
Routing: Configuration

Headphone - D/A - AES - MADI - PT Routing Output Source (similar)

<table>
<thead>
<tr>
<th></th>
<th>AES/EPU</th>
<th>AES 1</th>
<th>AES 2</th>
<th>AES 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>MADI 1</td>
<td>1-8</td>
<td>9-16</td>
<td>17-24</td>
<td>23-32</td>
</tr>
<tr>
<td>MADI 2</td>
<td>A/D 1</td>
<td>A/D 2</td>
<td>PT 3</td>
<td>Empty</td>
</tr>
<tr>
<td></td>
<td>Empty</td>
<td>Empty</td>
<td>Empty</td>
<td></td>
</tr>
</tbody>
</table>

For all of the output modules (AES 1-3, D/A N, MADI1-2, PT 3/6 & Headphone Jack) the user can set where the signal feeding it comes from. Any combination is possible using the Output source page linked to any of the output modules.

* All routing in the Horus is currently achieved using banks of 8 channels*

<table>
<thead>
<tr>
<th>None</th>
<th>Sets the module so that it does not receive a signal from anywhere. Digital Mute will be output.</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAVENNA</td>
<td>Connects the module to the RAVENNA network and allows any other RAVENNA device to send signal to it.</td>
</tr>
<tr>
<td>AES 1-3</td>
<td>Sets the module being configured to receive signal from any of the 3 banks of 4xAES-EBU input pairs.</td>
</tr>
<tr>
<td>MADI 1-2</td>
<td>Enables the module being configured to receive signal from any 8-channel bank in either of the MADI streams (MADI 2 appears only if the MADI Expansion Card is fitted.)</td>
</tr>
<tr>
<td>PT 3/6</td>
<td>Enables the module being configured to receive signal from any 8-channel bank in either of the PT64 modules. This module routing will open its routing menu when selecting its icon.</td>
</tr>
<tr>
<td>A/D N</td>
<td>Sends the signal coming in from the Mic or Line input modules to the output module being configured</td>
</tr>
<tr>
<td>ADA N</td>
<td>The ADA buttons, which become active if you have 1 or more ADA8 modules installed in the Hapi unit, give access to the Input controls.</td>
</tr>
<tr>
<td>Loopback</td>
<td>Should only be used for test purposes.</td>
</tr>
</tbody>
</table>

< ROUTING >
Modules Menu (Setup)

Module menu will show the available Horus Modules that your Horus has in its configuration.

Selecting one of the Modules described below will open the Module I/O configuration menu:

**Headphone**
Shortcut to the Headphone page described above.

**A/D N**
The A/D buttons, which become active if you have 1 or more AD8(P) modules installed in the Horus unit, give access to the Input controls. N being a number incrementing from 1 to 6 (when looking from the rear of the unit number 1 is left top, 6 is bottom right) referring to which of the six slots the module is inserted into. Please see below for a description of the buttons available.

**ADA N**
The ADA buttons, which become active if you have 1 or more ADA8 modules installed in the Hapi unit, give access to the Input controls.

**D/A N**
The D/A buttons become active when 1 or more IOC-DA8(P) modules are installed in the Horus unit.

**PT 3/6**
The PT buttons become active when an IOC-H-PT64 module in Slot 3 or Slot 6.

**MADI 1-2**
MADI 1 port is included as standard with each Horus.
MADI 2 will be listed as “EMPTY” in Horus units which are not fitted with the optional MADI expansion card.

**AES 1-3**
Included as standard. The AES buttons are active since this module is included as standard (as the MADI 1 module). Connectivity is over 3 D-SUB25 connectors providing 24 channel (12 AES pairs) of AES-EBU I/O.

**TimeCode**
Included as standard. The TimeCode button is active since this module is included as standard and will bring you to the TimeCode page.
Modules: MADI Sub-Menu

MADI 1 port is included as standard with each Horus. MADI 2 will be listed as “EMPTY” in Horus units which are not fitted with the optional MADI expansion card.

Mode: Sets the MADI mode to either “Standard” (56 audio channels) or “Extended” (64 channels). To determine which setting(s) you are able to use, please consult the user manual of the device you are connecting the Horus to in order to see which (if not both) formats it complies with.

*Note: MADI Standard (56) can only be enabled at 1FS (44.1kHz/48kHz) above 1FS we will automatically revert to MADI Extended (64).*

Physical Mode: Choose the input signal to be derived from the Coaxial or Optical MADI connections at the back of the Horus unit. You can choose to use either or, but not both at the same time. On the Output side, however, both Coaxial and Optical outputs are always driven in parallel.

88.2/96k: Choose between using 48k Frame (Legacy) or 96K Frame (High-speed). This option is only available for MADI output at 88.2/96kHz sampling rate and is dependent of the device used in conjunction with the Horus. For information on why you might want to set this to something other than Legacy/48K Frame, please consult the user manual of the device you are connecting Horus to.

*Note: Mykerinos users who are connected to the Horus should configure their Mykerinos Pyramix general settings so that the MADI High Speed mode is disabled and then set the Horus to 48k Frame (legacy).*

Output Sources: Users can route literally any input signal to any output module. Users can also route any input signal to any combination of output modules. Signals are routeable in blocks of 8 channels.

The example picture below shows a MADI output routing:

<table>
<thead>
<tr>
<th>Output Source</th>
<th>Module AES 1</th>
<th>Module AES 2</th>
<th>Module AES 3</th>
<th>Module A/D 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFS 1 (1-8)</td>
<td>Routed to MADI channels 1 to 8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AFS 2 (1-8)</td>
<td></td>
<td>Routed to MADI channels 9 to 16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AFS 3 (1-8)</td>
<td></td>
<td></td>
<td>Routed to MADI channels 17 to 24</td>
<td></td>
</tr>
<tr>
<td>A/D 1 (1-8)</td>
<td></td>
<td></td>
<td></td>
<td>Routed to MADI channels 25 to 32</td>
</tr>
</tbody>
</table>
Modules: AES Sub-Menu

Output Source: Shortcut to the Output Source Routing Page configuration

Modules: A/D Sub-Menu

Mic Alignment: User can offset the Mic Gain Alignment scaling from a range of 0dB to +12dB.

Example: Setting a gain alignment of +10dB will make the Horus, Web Access or the Pyramix PreAmps control to be offset by a scaling of +10 dB.

Serial Number: This is the place you can access all your Modules serial numbers without having to unslot them or open the box

Type: Module Type description

Output Source: Shortcut to the Output Source Routing Page configuration
Modules: ADA Sub-Menu

Mic Alignment: User can offset the Mic Gain Alignment scaling from a Range of 0dB to +12dB. Example: Setting a gain alignment of +10dB will make the Hapi, Web Access or the Pyramix PreAmps control to be offset by a scaling of +10 dB.

Max Level Maximum Output Level: +18 dBu or +24 dBu

Output attenuation: Calibration of the D/A output (Range -60.0 dB to 0 dB). Refer to the Hardware section for the D/A onboard output level calibration.

Roll Off Filter: Sharp roll-off filter: Offers a flat frequency response up to 22kHz, within 0.2dB, which has the tradeoff of 36 samples latency. This mode was and still is the default one.

Slow roll-off filter: Offers a low latency of 9 samples, with the tradeoff of a gentle frequency response attenuation starting around 16kHz and reaching -2.5dB at 22kHz

Serial Number: This is the place you can access all your Modules serial numbers without having to unslot them or open the box

Type: Module Type description

Output Source: Shortcut to the Output Source Routing Page configuration
**Modules: D/A Sub-Menu**

- **Output attenuation:** Calibration of the D/A output (Range -60.0 dB to 0 dB). Refer to the Hardware section for the D/A onboard output level calibration.

- **Roll Off Filter:** Roll Off Filter: Sharp roll-off filter: Offers a flat frequency response up to 22kHz, within 0.2dB, which has the tradeoff of 36 samples latency. This mode was and still is the default one. Slow roll-off filter: Offers a low latency of 9 samples, with the tradeoff of a gentle frequency response attenuation starting around 16kHz and reaching -2.5dB at 22kHz.

- **Serial Number:** Module serial numbers

- **Type:** Module Type description

- **Output Source:** Visual indication of the current Output Source, selecting the source will bring you to the Routing Page configuration.
**Modules: PT Sub-Menu**

**Emulation mode:**
Selection of the Hardware emulated in Pro Tools. Latency is adapted to the mode chosen, see detailed table in IOM-H-PT64 section. *None* mode is seen as an HD MADI in Pro Tools, but has the lowest latency.

**Serial Number:**
Module Serial Number and Run

**Output Source:**
Selection of the output source sent to Pro Tools for each of the 8 groups. Any of the digital or analog inputs can be routed to Pro Tools as well as RAVENNA signals.

Here is an example of routing:

- PT 3 (1-8): Routed on PT 3 (1-8)
- PT 3 (9-16): Routed on PT 3 (9-16)
- PT 3 (17-24): Routed on A/D 5 (1-8)
- PT 3 (25-32): Routed on AES 1 (1-8)
- PT 3 (33-40): Routed on AES 2 (1-8)
- PT 3 (41-48): Routed on MADI 1 (1-8)
- PT 3 (49-56): Routed on MADI 1 (9-16)
- PT 3 (57-64): Routed on RAVENNA
Modules: Loopback (hidden menu, available only for debug use)

Transparency Check: This is a Debug Utility tool that verifies the bit transparency of the audio path
On: Transparency check enabled
Off: Loopback mode enabled

Word Length: Word length of the digital audio data signal (16 bits or 24 bits)

Status: Green: Path transparency valid
Black: Path is not transparent
Numbering: indicates the number of discontinuities measured

Latency: Output to Input delay in samples

Output Source: Shortcut to the Output Source Routing Page configuration
Presets Menu (Setup)

Load: 5 presets banks of different Horus configurations can be loaded (one at a time)

Save: 5 presets banks are available to store different Horus configurations

Auto Save: If enabled the save configuration will happen at every 2 minutes.

Note: Since the flash memory which is at the heart of the Horus storage has a huge (but not infinite) amount of write cycles, we limit the auto-save of all configuration and PreAmps settings to once every two minutes if (and only if) a change has occurred meanwhile. Furthermore, both Shutdown and Reboot buttons (in Setup page) do also entirely save the current configuration of the Horus prior to power down.

Reboot to Factory: If selected we will reboot the Horus to the default factory configuration. The Current configuration will be lost but all the saved presets will be kept and can be reloaded.
System (Setup):

**ASIO Clock**
- **If set to Auto enabled:** The ASIO clock will be generated by the Horus which will be PTP Master.
- **If Auto is disabled:** The ASIO clock will always be generated by this Horus.
*Note: Do not disable unless you are sure that no Horus will be PTP Master.*

**TFT Screen Saver:**
- The Horus touch screen sleeper delay can be set to 15 minutes, 30 minutes, 1 hour or disabled

The Dark option will display a black Screen Saver, mainly used when Horus needs to be a discreet stage box.

**Latency:**
- The Horus has 4 Latency Settings (in samples) that will determine the device latency over a RAVENNA network. When multiple RAVENNA devices (e.g. Horus) are connected over a network, they adjust themselves to the lowest latency that can globally be achieved.
  - Ultra Low (16 smp)
  - Extra Low (32 smp)
  - (48 smp) – provisional for AES 67
  - Low (64 smp)

**Terminations:**
- **75Ω for WCK:** Sets 75Ω termination for the Wordclock Input. Enabling this will disable the Wordclock output.
- **75Ω for Video:** Sets 75Ω termination for the Video reference Input. Unless the Video Reference signal provided to the Horus is daisy-chained to other equipment, you should always terminate your Video signal for most reliable operation.
Backlight: Dim active will darken the Horus display luminosity. When active this saves some power and hence some internally generated heat.

Cooling Mode: Settings for either Low, Mid, High Cooling. This affects fan speed with reference to the temperature measured internally. While there is no universal preferred setting, we recommend that unless noise levels are a concern, you leave the setting on Mid or High for coolest operation and best protective results.
- Low: Fan starts above 45°C
- Mid: Fan starts above 35°C
- High: Fan always on at lowest speed (less noise), speed starts rising above 25 °C

The Fan OFF mode: Requested in order to stop the fan for quiet recordings
- The Fan OFF mode is not saved, so a Horus restart will always disable it
- The Fan OFF mode cannot be saved or retrieved from a Preset
- When the temperature of the Horus exceeds 70°C an error message will be displayed (for all modes). It is then required to shutdown your Horus for cooling purposes.

Network Menu (Setup)

Device Name: Horus_80062

IP Settings: Auto Manual

Address: 169 254 124 96
Netmask: 255 255 0 0

Device Name: Name of the Horus unit. This name will be broadcast across the network and will be seen in applications such as the MT Discovery tool. The Horus unit name can be changed from the Web control access Network page (see section below for all details)

IP Settings: Manual Type IP address using box selection and the - or + buttons
Auto: The IP address will be automatically attributed using ZeroConf/Auto-IP mechanism (address range 169.254.xx.xx if no DHCP server is present)

Address: Set the IP Address for the Horus unit by using box selection and the - or + buttons (Available only with IP Settings = Manual)
Netmask: Set the Subnet Mask for the Horus unit by using box selection and the < or > buttons (Available only with IP Settings = Manual)

Apply & Reboot: Once changes have been made to this section, you must press this button to save the settings and power cycle the Horus unit

Note:
Horus has no DHCP-server capability neither does the Merging PCIe Ethernet Controller Card NET-MSC-GBEX1.
By default the Horus IP setting is set to “Auto” configuration mode which gives an address in the range 169.254.xxx.xxx if no DHCP server is present on the network. Users are free to put a DHCP server in their RAVENNA network with a customized address range and the Horus would get an IP address from this server. Note that our recommended Dell PowerConnect 2816 RAVENNA switch is configured with DHCP disabled.

Merging recommend the Horus to be configured in “Auto” mode and the Merging PCIe Ethernet Controller Card NET-MSC-GBEX1 to also be configured with “Internet Protocol Version 4” with “Obtain an IP automatically”. You must be aware that when the Horus is started in Maintenance mode the IP configuration is exclusively done using “Auto” IP settings mode.

Info (Setup):

In this sub menu you will find details about the Horus internals: current consumption, voltage, temperature, fan speed, serial number and the firmware version currently installed.

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Current [mA]</th>
<th>Primary [V]</th>
<th>Secondary</th>
</tr>
</thead>
<tbody>
<tr>
<td>+15V</td>
<td>310</td>
<td>+16.41</td>
<td>+12.04</td>
</tr>
<tr>
<td>+5V</td>
<td>1060</td>
<td>+5.45</td>
<td>+2.62</td>
</tr>
<tr>
<td>-15V</td>
<td>268</td>
<td>-15.02</td>
<td>9.96</td>
</tr>
<tr>
<td>-48V</td>
<td>0</td>
<td>+47.71</td>
<td></td>
</tr>
</tbody>
</table>

Temperature: 37 [°C]  
Fan speed: 1834 [rpm]  
Serial Numbers: H80028, ET80028, MA80028  
Firmware Version: 3.0.1h25564
Horus Web Control access

Installing and accessing the Horus Control interface remotely
To control and view your Horus remotely with a web browser make sure that you are using one of the Internet browsers below: Google Chrome (Highly Recommended), Mozilla Firefox, Opera, Apple Safari. * Microsoft Internet Explorer is not supported *

Then take the following steps:
1) If you did not install Pyramix v8 or Pyramix v9 proceed from step 2 to 3. If you have already installed a Pyramix go directly to step 4
2) Download the MTDiscovey.exe application to your system (PC or MAC installers are available) http://www.merging.com/products/horus/downloads
3) Make sure your Horus is connected to the same network as your system, and is configured with the correct IP settings (See “Setting up the Horus IP Address”)
4) Launch the MT Discovery tool (MTDiscovery.exe)

Any Horus devices on the network will be discovered by the MT Discovery tool and will appear in the folder tree under “RAVENNA Devices>Horus Devices”
- A mouse double-click on the Horus Device entry will open the Horus Web Interface in your default web browser
- Only Devices on the same network (same color in display) can have their I/O interconnected
*Microsoft Internet Explorer is not recommended for this*

MT Discovery Window

Using the Webpage, you can browse the Menus and change parameters in exactly the same manner as on the front panel TFT of the Horus unit in question.

*Warning:* It is mandatory that you connect the Horus to a Gigabit Ethernet Port or Switch for remote access.
Horus User Manual

Horus Web Access

All of the Web access menu pages will be similar to those on the Horus TFT display except for the PREAMP and Network menus.

Disconnection warning:

User will be warned if the remote web access to the Horus become offline/disconnected.

Horus Web Access Disconnected
Meters web menu

The Meters web menu will display the input metering of the modules present in the Horus

Horus Meters Web menu

Led indications:
- Red: Peak indication
- Blue: Alignment range
- Green: Signal indicator

The LEDs indicate the inputs levels of the AD1 inputs 1 to 8

Note: You can reset a module Peak by doing Mouse + Click on the Module display section. In the example above pressing A/D 1(8ch) will reset the peak displayed on the input 1.

Meters web Settings:

- Hot: Sets the level above which the meter display will be red. If set to 0dB this will mean clipping. Range -2dBFS to 0dBFS
- Alignment: Sets metering level alignment range (yellow LEDs). Range -24dBFS to 0dB
- Decay integration time: Sets the rate at which the level meter display decays after the level falls below the most recent Peak.
- Peak Hold: If ON it will keep the red Peak Hold Overload in display
PreAmp web menu
- Allows the creation of up to 8 groups
- Naming of channels (can be saved in Horus presets)
- VU Meters
For other parameters, please refer to the PreAmps module description (above)

Horus PreAmp Web menu

Horus Network Web menu

ALL GRP Will include all faders into the selected group
RMN GRP Will include the remaining faders into the selected group
RST GRP Will reset the selected group
RST ALL GRP Will reset all groups, all grouping will be reset to default

Network web menu
The Network page allows users to personalize a name for the Horus unit.
The Horus embedded User Manual

The Horus embedded User Manual can be opened by clicking on the question mark (?) sign at the bottom left of your browser. This will overlay the Horus User Manual on your Web control access page.

Horus Embedded User Manual

The Horus Presets:
Disk Presets can be stored and loaded on your local system where Horus is connected to.

Horus Preset menu

Save Presets
Load Presets
Up to 5 presets can be saved and stored in the Horus
Up to 5 presets can be loaded from the Horus
From Disk Users can load some presets that were stored on your local Hard Drive
To Disk Users can save some presets to your local Hard Drive
Reboot to Factory Will reset all the Horus parameters to the default factory settings

Note: Stored Horus preset have a .bin file extension. In order to be able to rename the Horus preset file at save the Chrome browser users will need to adjust this Setting.

1. Go into Chrome Settings
2. Click on Show advanced settings
3. Under Downloads, check the box « Ask where to save each file before downloading »
Now when clicking on « to Disk » a window pops up that allows you to change the name of the preset (.bin) file prior to saving it.

Note: When saving presets to Disk with the Chrome Brower it is possible that the save windows dialog does not show up. It such case it is due to the browser Pop-Up blocker configuration. Make sure that you allow pop-ups from your Horus.
Horus & Hapi setup examples

RAVENNA Network For DSD256 Mix/Record With Backup Recorder

Stage Equipment
- 1x PCIe HORUS with total of
  - 6x ADP Premium AD cards (48 Channels)

Mix/Recording Room
- MassCore Pyramis Recording System
- PSI 415M reference monitors
- Tangio Control surface
- Secondary Audio Device over USB/PCIe
- Talkback Microphones

Backup Recording/Editing Rig
- MassCore Pyramis Recording system
- Secondary ASIO Device (USB)

Description
In this diagram, RAVENNA is used to connect a system that is capable of a 48 track DSD256 recording.
In the recording/mix room, Pyramis MassCore is used as the production tool from beginning to end. By keeping this signal “in the box” over-use of DA and AD conversions are kept to a minimum, thus preserving the sound to the highest degree.
During the whole recording, a second Pyramis MassCore system is kept online. Using the background recorder, it acts as a “noop” and records the whole day ensuring that any mistakes in the control room are covered with the backup. The second system can also double as a second recording and editing station for busy studios.

RAVENNA Network For Mix/Record and Live transmission of multichannel performance

Stage Equipment
- 1x PCIe HORUS with total of
  - 6x ADP Premium AD cards (48 Channels)
- 1x USB/PCIe card (swap out card for one of the AD cards to provide a 40/8 configuration if needed)

Mix/Recording Room
- MassCore Osiris Mix / Replay Engine
- Pyramis Studio Recorder or mass computer
- PSI 415M reference monitors
- Tangio Control surface
- Secondary Audio Device over USB/PCIe
- Talkback Microphones

Broadcast Room
- Pyramis Native Music Pack
- MassCore Running Windows 64 bit/Bootcamp
- ASIO RAVENNA Driver
- Secondary ASIO Device (USB)

Description
In this diagram, RAVENNA is used to connect a system that will allow the user to record the multi-track event while at the same time creating a broadcast mix which will be embedded with the video of the performance for “live to all” transmission.
In the Mix/Recording room, the MassCore W/MetaH employee streams are feeding the AD inputs into the Osiris Media Server and Sequencer application to an H. In this, the stereo mix-bus output is then sent back into the RAVENNA network; in order to have it picked up in the broadcast rooms by the Pyramis Native. This laptop sends then monitors the signal to an ASIOInterface, which in turn is fed to the RAVENNA network for broadcast. At the same time as all of this is happening, the Mix/Recording room computer is also running ASIO Native, which allows for a live broadcast. The mix bus is then routed through the RigNexus network, using the ASIO RAVENNA driver and is able to record the same streams as are being fed to the Osiris without having to create a direct connection between the two applications.
The second CGL switch is in the Mix/Recording room is there for future expansion where a redundant recorder could be put in place by simply plugging into the switch.
RAVENNA Network for Orchestral Recording with Multiple Microphone Positions

**Description**
This RAVENNA network example shows a recording when microphone placement varies greatly with respect to the position of the orchestra. As microphone cable lengths need to be kept to a minimum length, being able to place the Mic-pre and AD conversion stage closer to the source is important. This setup is possible as the Horus unit can be placed next to the microphone setup and less interconnections using the Horus network switches.

Once the streams reach the control room, they are recorded and mixed in the Pyramis MassCore rig by using the Tangent control surface as a remote interface to control everything for the Mic level to all of the EQ and summing that is needed for the mix. One should take special note to see that also connected to the RAVENNA network is a Mac using a CoreAudio based recording application in this diagram. This means that the backup recorder can not only record the multitrack, but also the mix bus output of the Mic/Record MassCore Pyramis.

**Stage / Roof Equipment**
- 2xOCT-8RU5 on stage with a total of:
  - 1x AD/DA Premium AD cards (8 channels)
  - 1x AD/DA Premium AD cards (16 channels)

**Control Room Equipment**
- MassCore Pyramis main rec. and mix engine
- Mac Laptop backup recorder
- PS/221M reference monitors
- Tangent control surface
- Secondary audio device over USB/PCIe
- Talkback microphone

RAVENNA Network for Live Performance Broadcast

**Description**
This signal diagram describes a workflow where a performance is to be recorded while at the same time transmitted "live".

The signal comes from the stage and goes through the Horus units on stage to get into the RAVENNA network. The multi-track signal is then recorded in the mix and recording suite onto the main and backup machines. Notice that the backup recorder is connected using ASIO (CoreAudio also available) meaning that almost any DAW can be used for the backup recording. The signal is also mixed using the MassCore engine of the Main recording rig. The output of the mixing/recording rig is then fed back into the RAVENNA network and arrives at the broadcast/satellite truck for combination with the picture before being streamed to broadcast. The additional MADI card in the Horus in the broadcast truck also means that the broadcast truck is able to do its own multi-track recording at the same time.

**Stage Equipment**
- 2xOCT-8RU5 with a total of:
  - 1x AD/DA Premium AD cards (12/20 channels)
  - 3x AD/DA Premium DA Cards (24 channels)

**Mix/Recording Room**
- MassCore Pyramis main rec. and mix engine
- Pyramis Analog backup recorder
- PS/221M reference monitors
- Tangent control surface
- Secondary audio device over USB/PCIe
- Talkback microphone

**Broadcast/Satellite Truck**
- 1x MADI I/P
- 2x MADI O/P
- 1xOM-MADI MADI Expansion Card for a total of 1.5 MADI channels
RAVENNA Network For Edit / Mix Suite with Separate Machine Room

**Description**
The workflow example shows a typical dubbing and edit suite connected to a local machine room which contains all of the heat sensitive and noise-generating equipment.
The Network is being used to connect the RAVENNA-enabled equipment together.
But as RAVENNA can exist on the same network as other streams of information, the same network is being used to create the connection for the Tango2 control surface as well as to extended the DVI and keyboard/mouse connections for the Pyramid MassCore workstation. The video for the main screen is being fed from the SDI output of a VCube HD which is running on the same workstation as the Pyramid MassCore.

RAVENNA Network For Edit / Mix Suite with Separate Machine Room and VO Booth

**Description**
The presented signal diagram shows a post-production suite with an attached voice over booth, isolated for ease of recording.
In this case, the Horus is able to act as the central source for all of the audio in each room, due to the fact that the Pyramid MassCore software is able to co-ordinate the talkback and monitoring streams to the various rooms.
The Network is being used to connect the RAVENNA enabled equipment together. But as RAVENNA can exist on the same network as other streams of information, the same network is being used to create the connection for the Tango2 control surface as well as to extended the DVI and keyboard/mouse connections for the Pyramid MassCore workstation. The video for the main screen is being fed from the SDI output of a VCube HD which is running on the same workstation as the Pyramid MassCore.
RAVENNA Network for Multiroom Museum Installation

Description

In this multiroom installation, RAVENNA is allowing the control of the museum's audio-visual content through a single network infrastructure. The museum is divided into several rooms, each with its own audio and video equipment. The network allows for seamless control and communication between the rooms, enabling synchronization of audio and video content across the entire museum.

Each room is connected to the network through a RAVENNA node, which acts as a network bridge. These nodes are interconnected via a LAN switch, allowing for the transmission of audio and video signals between rooms. The network also supports the transmission of control signals, enabling the control of audio and video equipment from a central control room.

WiFi Router

Control Room

Room 1

Room 2

Room 3

Room 4

Room 5

RAVENNA Network for Multiple Mastering Suites with a Shared Machine Room

Description

This multiroom installation shows how to connect 3 master suites to a single, shared machine room. The machine room contains all of the source machines (DAP tape and other line sources) that are controlled using the RAVENNA network. The RAVENNA streams pass from the master suites to the Gb LAN switch and can then be accessed by any of the suites. As the control for the line inputs, as well as the sync information for the Horus is over the same network connection as the RAVENNA streams, it means that only one cable needs to go to the machine room. Control over the Horus is made with a second network connection to the Tango2 control surface.

Each DAPX-2 line output card is connected to its own suite, providing discrete line outputs (5.1 Surround + Stereo) to each mastering suite. It is also important to note that the RAVENNA connection will also allow for signal to be easily and instantly shared from control to control room as well, as any interconnections is possible over the RAVENNA network.

Live Room Equipment

- IOC-HORUS with
  - 3xDAP Premium AD cards with Mic/Line (24 Channels)
  - 3xDAP Premium DA Line Output Card (24 Channels)

Studio Equipment:
- Pyramis Native Turnkey
- PSI A21SM Near Field Monitors
- Tango2 Control interface using Oasis Protocol
RAVENNA Network for Concert Event with standard FOH console

Description
This signal diagram outlines a workflow where Horus and RAVENNA A&D are used to create an I/O system for a large live concert event.

The signal comes from the stage and goes through the Horus units on stage to get into the RAVENNA network. The multi-track signal is then recorded in the recording suite onto the main and backup machine. Notice that the backup recorder is connected using ASIO (CoreAudio also available) meaning that almost any I/O can be used for the backup recording.

The signal is also being sent in parallel to the FOH position and connected to the console using MADI inputs. The MADI outputs of the desk then feed back into the RAVENNA system and the signal is sent back to the FOH units on stage to provide speaker feed and monitor mixes. The MADI output is also being sent simultaneously to the remote devices so as to capture the mix as well as the discrete multitrack.

Stage Equipment
3x3C-HORUS with a total of
- 16xA/D cards (40 channels)
- 3x3D-A/D cards (36 channels)

Recording Rig
MassCore/Pyramis Main recorder
- Yamaha Native backup recorder
- PSI A37M reference monitors
- Tango2 control surface
- Secondary audio device over USB/PCI
- Talkback microphone

FOH position
3x3C-HRUS with
- 4x8-MJ03 MADI Expansion Card for a total of 96 MADI channels

RAVENNA Network for Multiple Studios with a Shared Live Room

Shared Equipment
IOC-HRUS with
- 1xA/D card with 64 input (8 channels)
- 3x3D-A/D card with 8 input (8 channels)

Studio Equipment:
- Studio 1: PC based DAW (Sequioa, SADIE etc)
- Studio 2: MassCore Pyramis
- Studio 3: Mac-based DAW (Nuendo/Protools etc)
- PSI A37M Reference Monitor
- Tango2 Control Interface using Oats Protocol
- Talkback Microphone

Description
In this signal diagram of a RAVENNA network we are showing an incredibly useful feature of the Horus interface. Each 8 channels of input or output can be shared between a number of DAWs, OR dedicated to a specific one, allowing for professional quality I/O to be setup in each virtual suite, even though it is all being managed by a central piece of equipment.

The diagram also shows that, by use of an ASIO or CoreAudio RAVENNA driver, 3rd party DAW solutions on either Mac or PC can connect to the RAVENNA network. This means that they can use the Horus I/O as well as share signal in between each workstation, provided of course all workstations operate at the same common sampling rate.
RAVENNA Network for Multiple Studios with a Shared Live Room

Description
This workflow example shows how best to connect 3 Pyra- mids studios in a single, shared live room. The RAVENNA streams pass from the Horus into the Gb LAN switch and on then be accessed by any of the studios. As the control netwok is over the same network connection as the RAVENNA streams, it means that only one cable needs to go to the live room.

In each control room, monitoring is achieved by using the “Secondary Audio Device Router” in Pyram. This allows a locally connected Audio interface to be used for multichannel monitoring as well as talkback to the musicians in the live room. It does this by bridging the Secondary Audio device into the RAVENNA network so that all of this routing can happen transparently in the Pyram Monitor Oct box.

Control over the Pyram is made with a second network device to the Tango2 control surface.

It is also important to note that the RAVENNA connection will also allow for signal to be easily and instantly shared from control to control room as well, as any interconnections is possible over the RAVENNA network.

Live Room Equipment
- AES67-HORUS with
- 1xDAW Premium AD cards with Mic/Line (80 Channels)
- 1xDAP Premium DA Line Output Card (8 Channels)

Studio Equipment:
- MassCore Pyram (could be Native as well)
- PSI 2213M Near Field Monitors
- Tango2 Control Interface using QLAQ Protocol
- Talkback Microphone
How to use the IOM-H-PT64 module with Digidesign HDIO

This document explains how to setup Pro Tools and the devices to use a Horus with an IOM-H-PT64 module alongside a Digidesign HDIO with just one HD Native interface. HDIO can obviously be replaced with any Digidesign Interface.

Hardware setup:
- Connect Port 1 of HD Native interface to Port 1 of IOM-H-PT64 on Horus
- Connect Port 2 of HD Native interface to Primary Port of Digidesign HDIO
- Connect Horus WCK Out to HDIO WCK In with coaxial cable
- Connect Horus to computer with Ethernet cable
- See Block Diagram at the end of the Document

In Horus:
- In I/O & Sync, select Sync: PT3
- In Setup -> Format enable Auto-Follow
- In Setup -> Format choose WCK Output wanted (usage explained further)
- In Setup -> Modules -> PT3, select Emulation mode: HDIO
- In Setup -> Routing route signals wanted to/from PT (NOTE: with only Port 1 connected, only PT3 (1-32) are used @ 1FS)

In Pro Tools:
- Select Clock Source : HDIO#3 WCK
  - Select 44k1/48kHz if WCK Output option is set to 44k1/48kHz
  - Select Sample Rate if WCK Output option is set to Follow SR

With this configuration, you are now able to record/read Analog or Digital Signals with Pro Tools.
Manage Mic PREs from Pro Tools MAC

To be able to manage the Horus Mic PREs from Pro Tools, the latest Merging RAVENNA CoreAudio Driver must be installed on the Mac OS.

1. The Horus must then be linked to the Mac OS directly with an Ethernet cable.
2. The Horus is accessible from Pro Tools once it is seen in the System Preferences -> Merging RAVENNA settings window.
   In Setup -> Peripherals -> Mic Preamps, select Type as PRE, and select channel number corresponding with the Slot your A/D module is seated in.
   You are now able to manage the Horus Mic Preamps options from Pro Tools.

All details are available in the MergingVirtual Audio Device (formerly Core Audio Driver) Guide:
**Pro Tools on PC Horus / Hapi**

Analog preamps can be controlled directly from within Avid Pro Tools running on a PC. In order to set Pro Tools up for Horus / Hapi preamp control follow this procedure:

1. Check the Horus / Hapi firmware version and update if necessary to v19734 or above.

2. Connect Horus / Hapi to the system running Pro Tools through the Ethernet port.


4. Install rptMIDI

5. Start rptMIDI

![rptMIDI control panel](image)

6. In the My Sessions section (top left) click on the + button to add a new entry.

7. In the Session section (right) rename the entry in the Local name: field to HorusPre.

8. In the Directory section (bottom left) select the Horus_80xx_mid_pre module entry to add it to the Participants list.

9. At the top of the Session section check the Enabled box to enable the session.

10. Close the rptMIDI control panel.

11. Open the MTDiscovey application and check that the Horus is connected.

12. Please see: Within Pro Tools on page 38 and follow step 10 and complete the subsequent steps in Pro Tools followed by restarting Pro Tools.
Use Horus-HAPI MIDI din
To be able to use Horus and Hapi MIDI din, on its sync break out cable (CON-D15-VTC)

Prerequisite:
- Make sure you use Horus / Hapi firmware V3.0.70.29299 or above.
- Make sure your device have its DIP switch correctly configured for MIDI (see MIDI connection section in Horus / Hapi User Manual for details)

Note: As of the Horus/Hapi serial number H80730/H90620 jumpers already have the factory configuration for MIDI support

On Windows:

Pyramix v10 > users:

Under the Pyramix Settings>Hardware>MIDI Sync page
In the Directory list, choose an Apple MIDI service suffixed by "...midi_din". This nomenclature correspond to the Physical MIDI DIN port of a Horus/Hapi product.

ASIO users:

1. Make sure your Horus / HAPI is detected in MT Discovery
2. Download ans install RTPMidi http://www.tobias-erichsen.de/software/rtpmidi.html
3. Start RTP MIDI
4. In My Sessions section, click on the + sign to create a new session, and name it.
5. Once the Session has been created, select the device_name_midi_din in the available streams and click on Connect.
6. The midi_din stream will be passed in the Participants section, you can now use it in your favorite application.

RTPMIDI do not properly always refresh, if you need to change your settings in RTPMIDI, you will have to restart the computer for the changes to apply.

On MacOS:

Horus / Hapi MIDI DIN port can be used directly from within any DAW running on a Mac. (RAVENNA Core Audio driver v2.0.28855 and above recommended).

In order to use a Horus / Hapi MIDI port in MacOS follow this procedure:

1. Check the Horus / Hapi firmware version and update if necessary to the latest version. (v28855 or above)
2. Connect Horus / Hapi to the system running the DAW through the Ethernet port. (v28855 or above)
3. Make sure your Horus / HAPI is detected in MT Discovery
4. All available MIDI DIN port available on the network will appear as a usual MIDI port. I.e. Reaper
Horus Firmware update procedure

1) Download the latest firmware available. Can be found at http://www.merging.com/products/horus/downloads

2) Make sure that the .bin downloaded firmware file is on a PC that is on the same network as your Horus. (Users who have received a .rar will first have to Unrar it)

3) Power up the Horus using the big power button, while pressing down the small triangle button in order to startup in Maintenance Mode

You can also reboot the Horus in maintenance mode from the Touch Screen Setup menu or from the Horus Web Access set up page.

4) Keep the small button pressed until the yellow caution border display appears on the TFT screen

5) Wait until the Horus is fully booted (the progress bar says “Ready”)
Note: If you wish to cancel the Horus Maintenance mode you can do so from the Web access page or by pressing the small physical power button, this will reboot the Horus in normal mode.

You can also press the small triangle button in order to reboot the Horus. Be aware that the small triangle button is only active for reboot when in Maintenance mode.

Warning: We do not recommend that you refresh the browser page or restart the Horus while a firmware update is in progress and we recommend only gigabit Ethernet port or switch connection. Refer to the Merging RAVENNA Network Guide for example
http://www.merging.com/products/horus/downloads

6) Open the MTDiscovey tool, you should see a device called "Horus in Maintenance Mode", double-click on it.

Note: If you do not see the Horus Maintenance Mode entry, reboot Horus in Maintenance mode and verify your Horus Ethernet Connection to the MassCoreGb Ethernet Card. If you still do not see the Horus maintenance mode under MT Discovery. Open your Windows Device Manager and look in the Network Adapter section. Disable and re-enable the Merging Technologies PCIe Ethernet controller.

Warning: Horus Maintenance mode uses Auto IP config. Therefore ensure that you the PC is configured to obtain an IP address automatically when performing a firmware update.
7) Your default web browser (Merging recommends Google Chrome for best results) should open up on a firmware update page

Note: If your web browser does not open on the firmware upgrade page, clear your browser history and re-open the Horus page by Double Clicking on the “Horus in Maintenance Mode” entry in MT Discovery.

Note: Do not perform a Firmware upgrade if you plan to install Pyramix v8 simultaneously. Proceed only with one at a time.

8) Click on “Select File” and choose the file (.bin) that you have previously unzipped on your disk

9) Click on “Update Device” (after a while, you will see some messages on the TFT screen).

   Warning: During update do not update your browser (refresh), until the process is completed. The Firmware update should take from 3 to 5 minutes.
   You can see progress indicated at the bottom of your Browser Page and on the Horus screen

10) Wait until the webpage says “Update successful!” and Horus TFT displays “Update Done”.

Warning: Some Firmware updates will require first a Horus Maintenance Mode update. In such case you might see a message posted like “Wrong maintenance version, must be >= 31”.

Note: A Maintenance Mode update requires a shutdown of the Horus once the update completed.
11) Reboot your Horus after the Firmware update.

12) You can verify the firmware version installed by going into the Horus Setup menu and selecting System info. The firmware version and date of issue will be displayed.

<table>
<thead>
<tr>
<th>Serial Numbers:</th>
<th>H90007, ET90007, SA90000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware Version:</td>
<td>3.0.1b25564</td>
</tr>
</tbody>
</table>

**IMPORTANT:** If the Firmware update procedure fails, repeat the Firmware update procedure by pressing the “Try Again” Button (it will bring you back to step 7)

Avoid powering down the HORUS if the firmware update has failed. It is mandatory that you attempt to re-update the firmware, refresh the online web page if necessary. Or go back to the previous browser page and select the firmware again and re-update it. If you do not proceed in this way the Horus may no longer start up. Then a return to factory might be required.

If a fail message is posted saying “Wrong maintenance version, must be >= 31”. This means that you must first install the latest Maintenance Firmware prior to updating to the latest Firmware

Contact us at support@merging.com if your firmware update cannot be executed
Horus troubleshooting

Horus on screen Error Report

Your Horus can display on the TFT some detected errors. In case of an error report the Hours small Pyramix Home logo will be blinking Red. The user can then access the Horus Home button to view the error report, see the error list below as a reference. Once the issue is sorted Press the “clear” button to remove reported error.

Horus Error report example:

Potential reported errors:

"Primary Power Supply Failure";
"Secondary Power Supply Failure";
One of your Power supply is down, it is recommended that you eventually shutdown the Horus and verify your power cord connections

"Two Power Supplies Required" in case of more than 3 A/D are present
We will automatically detect the need for an additional power supply if your configuration requires it. Verify that both your Power supply are operational. It is recommended that you eventually shutdown the Horus and you have adequate power cord connections. For more details please refer to the “Redundant power supply options” describe above in this User Manual.

"Temperature too high";
You are exceeding the maximum recommended operating temperature of 65[C]. Configure your cooling mode to High or immediately shutdown your Horus. Note the Temperature lecture can be viewed under the System Info page

"Horus Application failure, please reboot"
The Horus internal application has failed. Will require a reboot, make sure that you are using the latest Horus firmware available. If the problem persists contact support@merging.com

"Fan failure"
Make sure that your Fan is not blocked by an object

"Ethernet input: GP fifo overrun";
"Ethernet input: GP descriptors fifo overrun";
The Ethernet communication is overloaded. The bandwidth is too small. Verify your set up, take note that a RAVENNA Network configuration must be running on a dedicated and certified Merging Switch. If problem persists contact our support team.
"Ethernet input: Audio packet still pending";
"Ethernet input: Audio pipeline too small";
"Ethernet input: Wrong sequence number";
"Ethernet input: CRC error";
"Ethernet input: Queue mux error";
"Ethernet input: Audio buffer too small";
"Ethernet input: SSRC mismatch"

Error on the incoming RAVENNA streams. There might be a click on the physical output of the Horus. Such a click could have occurred on one of the RAVENNA bank of 8 channels. Verify your setup, mainly on the network side and afterwards clear the error. If the problem persists contact our support team.

"Ethernet input: Unknown error";
"FPGA memory: Timeout";
"FPGA memory: Unknown error"

Contact Merging Support

“48V power failure: all A/D 48V forced off until next reboot”
The attached error message is displayed when:
1. 48V is malfunctioning
2. If there is a short circuit on 48V

If a MAJOR (by MAJOR, we mean that the threshold of short-circuit detection requires at least 10 Preamp inputs to be shorted simultaneously) 48V Phantom Power Supply short circuit is detected, 48V is forced off on all A/D channels and the following error message is displayed.

Note: 48V will be forced off until reboot.
Note: the user 48V settings are not affected i.e. the UI still shows the 48V as configured by the user.
How to provide Merging Support with a Horus debug dump file

1. Connect the Horus to your system via Ethernet
2. Open MT Discovery and click on the Horus Entry

![MT Discovery](image)

3. This will open the main Horus Web Access page in your web browser (e.g. Google Chrome)

![Horus Web Access](image)

4. Follow the Horus Name entry <Horus name>.local/ with /debug.html
Example: horus_80064.local/debug.html

![Horus Debug Page](image)

5. The Horus Debug page will open (see image below)

6. Click on the Get Report button
7. This will save Horus_Report.bin file.
8. Send the .bin files and report to support@merging.com
Cannot access Horus remotely in Maintenance mode for Firmware update

Procedure:
5. First launch MTDiscovery and open the Horus Maintenance Mode entry
6. If such entry does not show up, reboot your system and retry
7. If it still does not work, make sure that your Network card is set to Automatic IP addressing (see page 58 above)
8. If case none of the above works, make sure that the Horus if well connected to your system via Ethernet. It is mandatory that the Ethernet port or Switch is a Gigabit one.
9. Make sure that the Ethernet cable is Cat 5E or 6
10. On the Horus Maintenance TFT screen take note of the written IP Address
11. Type this address in your Chrome browser followed by :8080
   Example: 169.254.182.31:8080

   You should now have access to the Horus remote Maintenance page and be able to update your Horus firmware.

Firewall and Antivirus

Windows Firewall:
The Windows Firewall can block communication between MassCore and Horus. We recommend users to disable the Public Network Firewall
Procedure:
1. Go into Windows Control Panel > Windows Firewall.
2. Click on “Turn Windows Firewall on or off”
3. Go to the Public Network section and select “Turn Off Windows Firewall”

Disable Antivirus:
Merging also recommends users to disable their Antivirus, some Antivirus as Avast or Sophos have been known to block the Horus discovery and RAVENNA I/O Connections
Symptom: Horus does not start up or will after a few minutes

Please refer to the technical Horus document to solve the issue of the Horus not restarting.

To make sure that this is the problem you are encountering. Please look through the Horus right side panel air flow holes, you should see a green light that is blinking rather than steady. If the light is blinking this means that you should contact Merging support or your local dealer in order to obtain the technical document on the voltage adjustment procedure.

Note: it is also possible that you hear a small regular tick, tick sound noise coming from the Horus under such circumstances.